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WELCOME TO BILLQUICK!

Here is what you need to set up your company in BillQuick® and also a few links to help
you get started.

If you are new to BillQuick and want to understand this product, you can check out
Understanding BillQuick, BillQuick Workflow and its Key Features. You might also
want to go through the BillQuick Help in depth.

If you are an existing user of BillQuick, you might be interested in knowing about the
new features in BillQuick 2016. You can also check out the What's New in BillQuick
2016 list.

If you are a principal/partner, owner or manager of a company, you might want to
check out Executive Summary that presents the major features of BillQuick useful for
managing your projects, billing and overall business.

If you are a system administrator or IT supervisor, you might want to sign up on our
website or call us to get your License & Registration keys. You might want to find out
which BillQuick Edition is right for your company. Get started by creating a new
company database and setting up master information. For a quick startup, use the
BillQuick Startup Interview and Initial Setup Wizard.

If you have been using another time billing or accounting system, you can convert or
import that data into BillQuick. You can also bring your existing data from an
accounting program into BillQuick by integrating with it. If nothing else, you must
enter your opening balances into our system.

If you are a manager or supervisor, you might want to specify security settings,
global settings, user or other preferences for your company and individual users.

If you are a timekeeper or an employee, learn more about logging time and
expenses for work done on projects.

If you are a project manager, you might want to know all about tracking and
managing projects. You should also check our powerful reports.

If you are a billing manager or accountant, you might want to know all about billing,
retainers and invoices. BillQuick offers a whole range of accounts payable and
receivable features.

.

I‘Q-f'Your feedback helps us plan and improve BillQuick releases and associated
documentation. Please email your comments, suggestions and ideas about BillQuick and this
Help to BQ-Ideas@bge.com.

© Copyright 2016 BQE Software, Inc. All rights reserved. No part of
this publication may be reproduced, transmitted, stored in a retrieval

bqe system, or translated into any language in any form by any means

without written permission of BQE Software, Inc.
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INTRODUCTION

UNDERSTANDING BILLQUICK

BillQuick is a time and expense tracking, billing, project and business management solution.

Initially used by architects and engineers, BillQuick has grown to be adopted by every type
of service professional. Consultants, programmers, accountants, attorneys, contractors, etc.
have all discovered the unmatched features and flexibility of BillQuick and made it their time
billing solution. Virtually any company that tracks hours for job costing (and payroll) or bills
by fixed fee, recurring amount, hourly, cost plus and variations will find strong value in
BillQuick. You can check out various features of BillQuick suitable for the following broad
categories:

e BillQuick for Accountants

e BillQuick for Architects & Engineers

e BillQuick for Attorneys

e BillQuick for IT Consultants
Benefits

BillQuick offers an easy and efficient way to reduce the overhead of your business and
increase your revenue by accurately tracking professional hours, recording expenses and
job costs, managing projects, billing your clients and reporting. Companies report saving
10, 25 and more hours monthly because of shortcuts, automatic features and simplified
tasks in BillQuick. You can reduce your billing time from days to hours, accessing BillQuick
on the desktop, web and smartphones. In addition, you get to integrate BillQuick data with
your accounting package. To gain better insight about the basic flow of data throughout
BillQuick, see BillQuick Workflow and to know how it addresses your business concerns, see
Executive Summary.

BillQuick adapts to various types and sizes of professional services firms—handling a two-
person firm as efficiently as a large multi-office firm. It is scalable to any size organization,
from small firms with 1 to 5 employees using the Microsoft Access database to mid-size with
5-20 employees who use the Microsoft SQL Server Express database, and large firms with
20+ employees using the Microsoft SQL Server Standard database.

BillQuick comes in 4 flavors or editions and is also available in 4 Plus editions having the
Accounts Payable module. It includes more than 500 reports and 180 invoice templates,
allowing you to meet the requirements of your most demanding clients and providing in-
depth analytic tools to optimize all aspects of your business. You can check the various
editions of BillQuick:

BillQuick Lite
BillQuick Basic & Basic Plus

BillQuick Pro & Pro Plus
BillQuick Enterprise & Enterprise Plus

BillQuick also comes in three different versions. Depending upon what suits your company
and situation, you can use one or more of these options:
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BillQuick—flagship product, installed and accessed on desktop computers and laptops

e Web Suite—web version of BillQuick, accessed from web browsers using
Internet/Intranet/local network

e BillQuick Online—online hybrid SaaS version of BillQuick, hosted by us and accessed
by subscribers from web browsers using Internet

e BillQuick Mobile—mobile app, downloaded and accessed on iPhones, Android phones

and other compatible mobile devices like Windows phones

BILLQUICK WORKFLOW

BillQuick is a highly flexible software solution and hence adapts to your business and
company preferences.

U-)To get started with BillQuick, a Supervisor or administrator needs to first set up the
Company database. You can do this by entering new data, importing it from external
sources or integrating it with your accounting packages. This is followed by setting up of

master information—employees and vendors, ©) clients, @ activity and expense items, ®
projects and related information such as fee schedules, budgets and estimates, and billing
schedules. Time and expense entry requires data input from this master information.

Employees or vendors charge @activities and @ expenses against various projects while

recording time and expense entries. ® In addition, you can convert vendor bills into time
and expense entries or vice versa. Approved time and expense becomes work-in-progress,
ready to bill.

®Billing decisions begin with the client and project setup (master information). When ready
to bill, accumulated work-in-progress or pre-defined billing schedule flows to the Billing
Review or Manual Invoice. You can also use the wizards to do your billing. After processing

and reviewing invoices, ) the manager typically generates final invoices in Invoice Review

and sends them to the clients. ® BillQuick tracks accounts receivable and then records
payments when received. Some companies prefer linking the payment of vendor bills with
the payment received from their clients (pay when paid). Throughout the BillQuick
workflow, useful reports are available for the staff and management.

Click on the desired areas of the image for details.

BillQuick | Power Up Your Business 30
(866) 945-1595 | www.bge.com | info@bge.com


http://www.bqe.com/
mailto:info@bqe.com
http://www.bqe.com/ProductOverview.asp?prodId=BQ
http://www.bqe.com/ProductOverview.asp?prodId=WS
http://www.billquickonline.com/Default.asp
http://www.bqe.com/ProductInfo.asp?prodId=BQ&link_src=BQMobAppBanner

¢ BillQuick s

Masterinfo

|

COMPANY ... |

Add Data
mport Data

Billing

S—
BILLING >
b T&E ‘ REVIEW &
VENDORS \-E ? |
‘ i TIME

ENTRY %
J L @ . MANUAL

%)

g;:; | INVOICE .\

:
o)

A/R

i
I

@NVOICE L PAVMEN'I:S‘_

REVIEW :
—~ < b 74
ACTIVITY EXPENSE
CODES ¢~ ENTRY
.l 1 INVOICE _ .| A
EXPENSE_ g WIZARDS “Zims
CODES ~ ™= Y . 2
- A ?@‘
| BUDGETS & |
PROJECTS - _ - ESTIMATES
97 e I
'\\.‘___
BILLING
SCHEDULE

\ J ? VENDOR =t ‘Pay When Paid’
L BILLS 1::mm|]

EXECUTIVE SUMMARY

Implementation of BillQuick for time tracking, billing and project management is the right
step towards increasing business productivity and investing in technology that helps you
manage your business. This executive summary highlights those functions and features of
BillQuick that are useful for decision-makers and executives in a company. It focuses on
important information needed by owners, principals, partners, executives, project
managers, billing managers, company managers and such other people for effective and
efficient management of projects, company and business as a whole. In other words, it
answers your question "What does BillQuick do for me?"

Depending upon your business type, BillQuick adjusts its terminology and activity codes to
your industry:
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Industry-Specific Terminolog

Architects & IT & Computer Accountants Attorneys &
Engineers Consultants & CPAs Paralegals
Employee Employee Timekeeper Employee

Client Customer Client Client
Project Job Engagement Matter
Activity Activity Task/Service Activity

Company Company Company Firm
Vendor Vendor Consultant Consultant
Budget Budget Budget Estimate

BillQuick provides various solutions and features that enhance the overall productivity and
profitability of your business concern—whether you are an architectural, engineering, IT,
accounting or any other professional services firm.

BillQuick for Architects and Engineers
BillQuick for IT/Computer Consultants
BillQuick for Accountants/CPAs
BillQuick for Attorneys

Some critical aspects of a business are a major concern for all executives in any industry.
BillQuick addresses all those concerns in a simple yet smart manner.

Project Management

BillQuick provides the following solutions and benefits, enabling you to manage your
projects in the most efficient way.

Project Center
Project Merging
Project Notes

Budgets
Estimates

Service and expense fee schedules
Project and employee controls
Assign Items to Projects

Allocation and Forecasting
Workflow Event Tracking
Dashboard

Automatic Billing

Project Reports

Document Management

Billing Management

BillQuick provides the following solutions and benefits, enabling you to manage your billing
accurately:
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Time and Expense Tracking
Submit-Approve Process
Payment Terms
Currency Manager
Billing Schedules
Accounts Payable
Accounts Receivable
Write-Up/Down

Manual Invoices
Memorize Invoices
Billing Reports
Payments

Retainers

Statements

Collection Center

Company & Business Management

BillQuick provides the following solutions and benefits, enabling you to manage your overall
company and business smartly:

BillQuick Messages
File Linking

Memos

Filters
Customizable Grids
Cloning

Find or Search
Batch Change
To-Do Lists
Security Settings

Log Viewer
Reminders

Grouping

Auto Complete
Custom Labels
Archive and Restore Data
Database Maintenance
Emailing

Wizards

Global Settings

User Preferences

Data Integration
Reports
Import-Export Data
Data Conversion
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BillQuick Features

KEY FEATURES

BillQuick provides simple, intuitive yet powerful features for your time and expense
tracking, billing, project and business management, and reporting needs. Some of the key
features of BillQuick are:

Available in several editions and versions to suit your
needs and preferences. It is suitable for small to large
network-based organizations with various database options
(Microsoft Access, SQL Server Standard and SQL Server
Express). You can use the desktop, browser-based, online
SaaS or mobile version of BillQuick—anytime and anywhere.
High network compatibility with multiple users.
Easy-to-use and intuitive interface with multiple navigation
options. You can access its screens and features using
menus, shortcuts, toolbars, sidebars and navigators.

Highly customizable and flexible grids; option to apply
smart filters and powerful search function throughout the
program, including reports.

Highly secure with a complete built-in security system.
Allows employees to enter their time but limits their access
to confidential information.

Provides user-assistance via wizards for all the important
functions.

Suitable for timekeepers and vendors alike. Includes control
features like project control, security permissions,
submission-approval, budgets, project rules and settings.
Includes task allocation and revenue forecasting
features to keep timekeepers on track and promote self-
policing.

Easy-to-use Personal Time Off management feature.
Provides up to four levels of project hierarchy, with well-
defined parent-child relationships. An exclusive Project
Center designed for project managers, partners, principals
and owners.

Complete project management tools including scheduling,
workload and revenue forecasting, task assignment, project
notes, etc.

Budgets and estimates for tracking project progress.
Document Management feature handles client and project
file management, folder creation and email review.
Automatic reminders and email notifications regarding
time and expense approvals, backup, sync, invoices, etc.
Offers file linking and attachments option in all screens.
Allows you to create and maintain to-do lists and tasks.
Messaging within the BillQuick network, besides information
tracking via memos, notes, etc.
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Handles simple as well as complex time and expense
tracking of employees and vendors in your company. You
have several ways to record and review time and expenses.
Handles multi-task time tracking using stopwatch timer.
Tracks your activities with precision and ensures no time
goes unrecorded and unbilled.

Fee Schedules to allow variable billing. You can bill your
clients based on special pre-defined rates. Additional Delayed
Service Fee Schedule for retainer-based variable billing.
Flexible billing with several billing methods and contract
arrangements. You can choose from 12 contract types and
do batch billing, progress billing or regular billing.

Allows creating of manual invoices with or without time and
expenses.

Allows you to set automatic billing schedules and
memorize invoices on a specified frequency.

Flexible charging or billing using the write-up/write-down
feature.

Tracks retainer history with a complete retainer
management system.

Handles accounts payable functions such as paying vendor
bills, making deposits, writing checks, etc.

Streamlines the manual process of filling out and tracking
purchase orders.

Extremely powerful reporting feature. You can run reports,
invoices and statements from various places in BillQuick.
Extremely flexible. All invoices, statements and reports are
customizable with Crystal Reports; screen and field labels
are customizable too.

Data exchange and integration with various accounting
software like QuickBooks, Sage 50 (formerly Peachtree),
MYOB, etc. Also allows import-export of data.

HELP MANUAL:
BillQuick Help

BillQuick comes with an excellent and reliable technical support via email or phone. You

have free access to our support resources and documentation.

NEW FEATURES IN BILLQUICK 2016

There are hundreds of new and improved features added to BillQuick every year. The major

new features in BillQuick 2016 include:

1. Import Bank and Credit Card Transactions: In BillQuick 2016, you can download
your bank and credit card transactions and import them automatically to their
registers. If BillQuick finds that the transaction already exists in your company file, it
matches the entry to prevent duplication of data. This is a huge time-saver for
businesses that use credit cards or have a large set of bank transactions every

month.
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2. Auto Open Your Favorite Screens: A simple yet powerful Startup section is added
to the User Preferences screen where you can specify up to five of your favorite
screens that BillQuick will open automatically for you every time you log in.

3. Track Credit Card Expenses: Many businesses use credit cards to make project-
related purchases. A new expense-level property in BillQuick allows you to select
which credit card is used for a specific expense entry. When you specify the credit
card, BillQuick automatically creates an A/P entry in the credit card register. This is a
huge time saver if you or your employees use credit cards for business expenses and
are reconciling your credit card line items manually.

4. Send Multiple Attachments as a Single File: If you are attaching receipts and
other backup documents to your invoices and emailing them to your clients, you
might be overloading your clients with too many email attachments. In BillQuick
2016, you can send all invoice-related attachments as a single .zip file. This not only
minimizes the email attachments, but also makes it easy for your clients to find all
the backup documents inside one file. Your clients will thank you for this and
hopefully pay their invoices faster.

5. Auto-Update Project Data: Here is an easy way to change the invoice templates,
fee schedules, payment terms or currency on all the projects of a specific client;
make the change in the client record and let BillQuick update all the associated
projects automatically.

6. Backup SQL Database: No need to call your IT person or remote into your SQL
server to back up your BillQuick SQL database. In BillQuick 2016, we added the
capability to initiate the backup within the application. Safe and simple.

7. Auto-Include Phases: When reviewing the time, expense or invoice data for a
project with phases, simply select the parent project and then BillQuick automatically
includes all its phases and sub-phases. This is an efficient way to preview the data
on your project with one click.

8. Memo on Pay Vendor Bills: Want to add a check or EFT memo to the bills paid
through the Pay Vendor Bills screen? We added a new Memo attribute in the Pay
Vendor Bills screen that automatically populates the memo field on the associated
check. No more double editing.

9. Project Level Retainer: While BillQuick always supported project retainer, it was
not possible to receive a retainer for a parent project and then let its phases use it.
With BillQuick 2016, you can now receive the retainer at the top parent project level
and then apply all or a portion of that retainer to its phases and sub-phases.

10. Organize Purchase Order Items with Line Numbers: If you want your purchase
order line items to be sorted in a certain order, you can now control the order by
moving lines up and down and letting BillQuick auto-assign line numbers to them.

11.Time and Expense by Class: Here is another powerful use of the Class attribute in
BillQuick. We added a brand new “View by Class” filter to the Reviewer screen to
allow you to view all the time and expense data specific to the selected class or a
range of classes.

12.Line Items by Account in Vendor Bills: In BillQuick 2016, you can now have the
vendor bill line items link directly to a specific chart of account and therefore bypass
the need to specify the expense item.
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Vendor Checks, Credits and Discounts: In the Vendor screen, you can now get a
full picture of all the vendor bills received, checks paid, and credits and discounts
issued.

Windows Authentication Auto Login: Added a user preference setting where the
user can turn on Windows authentication. When turned on, BillQuick will skip the
login screen.

Ability to Change Client Contact ID: The Change ID utility now supports changing
the Client Contact ID.

Convert Employee to Vendor: You can now convert any employee to a vendor
with a single click.

Detail View of Unpaid Expenses: When you are writing a check to a vendor with
unpaid expenses, BillQuick 2016 alerts you of the unpaid vendor expenses and lets
you select the ones you are planning to pay. A huge time saver if the expenses are
already in the system.

Powerful New Reports: We have added quite a few useful reports to BillQuick
2016.

Performance Improvement: BillQuick 2016 is compiled using Dot Net Framework
4.5. This works with the latest version of the operating system such as Windows 10
and you will also notice significant performance improvements throughout the
program.

Security: A brand new Security section called “General” will allow users to override
Global Settings font selection.

Print Option Added to the Collection Center: The Print button added to this
screen will allow printing collection specific reports.

Update Bill Rate: Ability to change Bill Rate for time linked to Vendor Bills or
Checks.

Custom Field Auto-Update on Phases: When the value of a custom field is
changed at the parent project level, BillQuick 2016 will now ask if you want to
change the value for the related child projects.

Email Text Box Supports Auto-Suggest: When entering an email address,
BillQuick 2016 will show matching email addresses as you type.

Auto Exclude Non-Billable Time and Expenses from LEDES Export: When the
setting Exclude Non-Billable Time and Expense is checked, the LEDES export utility
will also exclude those entries.

Prevent Users from Altering the Shared Folder Setting: Two new security bits
for attachments were added. (1) Allow Edit Shared Folder Setting (2) Allow Edit
Folder Structure Setting. If turned off, user will not have the option to changes these
when attaching a document.

Reviewer: Ability to select Date Filters using Named Date Ranges in the Reviewer
screen.

Pay Method Column in Payment History List: When reviewing an existing
payment in the Payment screen, the list now shows the payment method of each
payment listed.
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29. Process and Print Draft Invoices: Now you can process and print draft invoices
with a single click from the Invoice Review screen.

30. Ability to Select Which Reimbursable Items to Pay: When paying employee or
vendor reimbursable expenses in Pay Vendor Bills screen, BillQuick 2016 will now let
you choose which line items you are wanting to pay. Similarly, if you are creating a
Vendor Bill and want to auto-include the vendor’s reimbursable expense, you can
cherry-pick line items at that stage too.

BillQuick Editions

BILLQUICK EDITIONS OVERVIEW

BillQuick comes in four flavors or editions: Lite, Basic, Pro and Enterprise. It is also available
in three Plus editions having the Accounts Payable module. Depending upon your
requirements, you can choose the edition that fits you best.

|__Edition | Description | Database Type

Free, limited edition of BillQuick.
It is suitable for a one-man

B”:_?tue'Ck company that requires only Microsoft Access (Standard)
capture of time and expenses
and basic billing.
Low-end, paid edition of
_ _ BillQuick. I_t is s_mtable for small Microsoft Access (Standard)
BillQuick companies with few users. ;
. ) Microsoft SQL Server
Basic Offers time and expense
. . - o Express
tracking, invoicing, billing, and
reporting features.
Professional edition of BillQuick
BillQuick suitable for medium-sized Microsoft Access (Standard)
Pro companies. Offers more features Microsoft SQL Server
than Basic but less than the Express
Enterprise.
Top-of-the-line edition for large Microsoft Access (Standard)
. . companies with many users or Microsoft SQL Server
BillQuick
Enterprise those who need very robust Express
P features. Offers all the advanced Microsoft SQL Server
and new features. Standard
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BillQuick Flavors

BillQuick

Activity & Expense ltems
Clients

Employees, Vendors
Projects, Job Costing
Fee Schedules

Time, Expense
Billing

Accounts Receivable

Chart of Accounts
Accounts Payable
General Ledger
Banking

Financial Statements

Vendor Bills
Payments

G

Copyright BQE Software Inc

Fa—
I'k-ef'See the BillQuick Editions Comparison Chart for more.

BILLQUICK BASIC

BillQuick Basic is one of the editions or flavors of BillQuick designed for small firms with
basic requirements. It best serves one-person or small offices. Some features in the full-
version of BillQuick might not be available in this basic edition. You can enhance BillQuick
with Add-On Modules and customize it to the unique needs of your profession and office.

Invoices, statements and reports are customizable with Business Object's Crystal Reports.
Invoices and Statements can be specified for individual projects, enabling you to meet the
demands of any client. You do not need to change the way you run your business. BillQuick
Basic will adjust to fit your business the way you run it!

Key Features
e Network compatible with multiple users

e Microsoft Access/JET compatible database
e Time and expense tracking
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Project management including multiple contract types, budgets, and more
Billing and payments

More than 180 customizable invoices and statements

Reporting capabilities including memorized reports, statements, and more
Import/export and data conversion

Export reports and invoices to PDF and other file formats

Data integration with QuickBooks, Sage 50 Accounting (formerly Peachtree—US
Edition) and MYOB (Australia)

Telephone and email technical support

e 15-day free trial for evaluation

BILLQUICK BASIC PLUS

BillQuick Basic Plus is an edition or flavor of BillQuick that has all the features of BillQuick
Basic and also includes the Accounts Payable module.

BillQuick Basic Plus allows you to manage your time, expenses, projects, billing, reporting
as well as multiple A/P accounts. You can pay your bills, write checks, enter credits, transfer
funds and do much more with the bundle of features available with this edition.

BillQuick Basic Plus is designed for small firms with basic time and billing requirements in
addition to their accounting needs. It best serves one-person or small offices. Some
features in the full-version of BillQuick might not be available in this basic edition. You can
enhance BillQuick with Add-On Modules and customize it to the unique needs of your
profession and office.

Key Features

Network compatible with multiple users

Microsoft Access/JET compatible database

Time and expense tracking

Project management including multiple contract types, budgets, and more
Billing and payments

More than 180 customizable invoices and statements

Full Accounts Payable module

Reporting capabilities including memorized reports, statements, and more
Import/export and data conversion

Export reports and invoices to PDF and other file formats

Data integration with QuickBooks, Sage 50 Accounting (formerly Peachtree—US
Edition) and MYOB (Australia)

Telephone and email technical support

e 15-day free trial for evaluation

BILLQUICK PRO

BillQuick Pro is a professional edition or flavor of BillQuick. It is a higher version of BillQuick
employing the Microsoft Access/JET Engine and Microsoft SQL Server Express database for a
comparatively high-demand environment.
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You can enhance BillQuick with Add-On Modules and can customize it to the unique needs of
your profession and your office. Implementing BillQuick reduces overhead, helps produce
more accurate time tracking and increases profits.

Invoices, statements and reports are customizable with Business Object's Crystal Reports.
Invoices and statements can be specified for individual projects, enabling you to meet the
demands of any client. You do not need to change the way you run your business. BillQuick
Pro will adjust to fit your business the way you run it!

Key Features

e Network compatible with multiple users

e Microsoft Access/JET Engine and SQL Server Express compatible database

e Time and expense tracking

e Submittal-approval workflow

e Project management including multiple contract types, budgets, estimates,
allocation, dashboard, document management, to-do lists, and more

¢ Event-driven messaging and file linking

e Billing including automatic billing, progress billing, memorized invoices, and more

e Retainer management and payments

e More than 180 customizable invoices and statements

e Accounts payable such as vendor bills and chart of accounts

e Reporting capabilities including memorized reports, statements, and more

e Import/export and data conversion

o Data integration with QuickBooks, Sage 50 Accounting and MYOB (Australia)

e Telephone and email technical support

e 15-day free trial for evaluation

BILLQUICK PRO PLUS

BillQuick Pro Plus is an edition or flavor of BillQuick that has all the features of BillQuick Pro
and also includes the Accounts Payable module. It allows you to manage your time,
expenses, projects, billing, reporting and accounting tasks. You can pay your bills, write
checks, enter credits, transfer funds and do much more!

BillQuick Pro Plus is a higher version of BillQuick employing the Microsoft Access/JET Engine
and Microsoft SQL Server Express database for a comparatively high-demand environment.

You can enhance BillQuick with Add-On Modules and can customize it to the unique needs of
your profession and your office. Implementing BillQuick reduces overhead, helps produce
more accurate time tracking and increases profits.

Invoices, statements and reports are customizable with Business Object's Crystal Reports.
Invoices and statements can be specified for individual projects, enabling you to meet the
demands of any client. You do not need to change the way you run your business. BillQuick
Pro Plus will adjust to fit your business the way you run it!
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Key Features

Network compatible with multiple users

Microsoft Access/JET Engine and SQL Server Express compatible database
Time and expense tracking

Submittal-approval workflow

Project management including multiple contract types, budgets, estimates,
allocation, dashboard, document management, to-do lists, and more
Event-driven messaging and file linking

Billing including automatic billing, progress billing, memorized invoices, and more
Retainer management and payments

More than 180 customizable invoices and statements

Full accounts payable module

Reporting capabilities including memorized reports, statements, and more
Import/export and data conversion

Data integration with QuickBooks, Sage 50 Accounting and MYOB (Australia)
Telephone and email technical support

15-day free trial for evaluation

BILLQUICK ENTERPRISE

BillQuick Enterprise is a high-end edition or flavor of BillQuick employing the Microsoft SQL
Server Express or SQL Server Standard database for high-demand environments. BillQuick
Enterprise is an enterprise solution and best serves huge offices with huge data needs. This
top-of-the-line edition is for larger companies with many users. It comes with all advanced
and new features of BillQuick.

You can enhance BillQuick with Add-On Modules and customize it to the unique needs of
your profession and office.

Designed using the native SQL or SQL Server Express database driver, this program can
handle a large user base without any stress. The SQL database in BillQuick is extremely
stable and can be maintained via your SQL server maintenance program. This ensures
proper backup and quick restoration in case of hardware/software failure.

Invoices, statements and reports are customizable with Business Object's Crystal Reports.
Invoices and Statements can be specified for individual projects, enabling you to meet the
demands of any client. You do not need to change the way you run your business. BillQuick
Enterprise will adjust to fit your business the way you run it!

Key Features

e Network compatible with multiple users

e Microsoft Access/JET Engine, SQL Server Express and SQL Server Standard
compatible database

e Time and expense tracking
Submittal-approval workflow
Project management including multiple contract types, budgets, estimates,
allocation, dashboard, document management, to-do lists, and so on

e Event-driven messaging and file linking
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e Billing including automatic billing, progress billing, memorized and electronic
invoices, and more

Retainer management and payments

More than 180 customizable invoices and statements

Accounts payable such as purchase orders, vendor bills and chart of accounts
Reporting capabilities including memorized reports, statements, and more
Import/export and data conversion

Data integration with QuickBooks, Sage 50 Accounting (formerly Peachtree—US
Edition) and MYOB (Australia)

Telephone and email technical support

e 15-day free trial for evaluation

BILLQUICK ENTERPRISE PLUS

BillQuick Enterprise Plus is an edition or flavor of BillQuick that has all the features of
BillQuick Enterprise and also includes the Accounts Payable module. It allows you to
manage your time, expenses, projects, billing, reporting as well as multiple A/P accounts.
You can pay your bills, write checks, enter credits, transfer funds and do much more with
the bundle of features available with this edition.

BillQuick Enterprise Plus is a high-end edition or flavor of BillQuick employing the Microsoft
SQL Server Express or SQL Server Standard database for high-demand environments. It is
an enterprise solution and best serves huge offices with huge data needs. This top-of-the-
line edition is for larger companies with many users. It comes with all advanced and new
features of BillQuick. Designed using the native SQL or SQL Server Express database driver,
this program can handle a large user base without any stress. The SQL database in BillQuick
is extremely stable and can be maintained via your SQL server maintenance program. This
ensures proper backup and quick restoration in case of hardware/software failure.

You can enhance BillQuick with Add-On Modules and customize it to the unique needs of
your profession and office.

Key Features

e Network compatible with multiple users

e Microsoft Access/JET Engine, SQL Server Express and SQL Server Standard
compatible database
Time and expense tracking
Submittal-approval workflow

e Project management including multiple contract types, budgets, estimates,
allocation, dashboard, document management, to-do lists, and more

¢ Event-driven messaging and file linking

Billing including automatic billing, progress billing, memorized and electronic

invoices, and more

Retainer management and payments

More than 180 customizable invoices and statements

Full Accounts Payable module

Reporting capabilities including memorized reports, statements, and more

Import/export and data conversion
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e Data integration with QuickBooks, Sage 50 Accounting (formerly Peachtree—US
Edition) and MYOB (Australia)

e Telephone and email technical support

e 15-day free trial for evaluation

BillQuick Products & Services

BILLQUICK ADD-ONS

BQE Software offers other stand-alone products and add-on modules that can help you
effectively and efficiently manage your company. They expand the core capabilities of
BillQuick, providing you with smart tools and features.

To take benefit of these products, you need to purchase and install them separately. After
installation, you can access them from within BillQuick (Add-Ons menu).

.

I‘~-e-f'To learn more about other BQE products, please visit www.BQE.com/Products. 15-day
trial versions of add-on modules and stand-alone programs are available here. To check out
related support documents for each, please visit www.bge.com/Support. To purchase,

contact Sales at (310) 602-4020.

The BillQuick Family includes various software modules. All modules are available as
downloadable trial software (15-day evaluation period).

Product/Edition _Trial | __Lite | Basic | Pro _ Enterprise |

BillQuick Yes Yes Yes Yes Yes
BillQuick Online Yes — — Yes Yes?!
Web Suite Yes 2 — Yes Yes Yes
Agent Yes — Yes Yes Yes
Outlook Add-In Yes — Yes Yes Yes
BillQuick HR3 Yes — 3 3 3

Tt offers Enterprise and Enterprise Plus plans.

2BQE Software maintains a test server on the web for prospects to evaluate Web Suite. If
desired, they can download Web Suite and install it on their local network.

3BillQuick HR is not segmented into editions like other modules. This module includes all features
available for the software.

This section briefly highlights the core capabilities and benefits offered by major BQE
Software products. Accordingly, you can decide to use the ones better suited for your
company and situation.

BillQuick Online - online version of BillQuick

e It is a subscription-based, hybrid Software-as-a-Service (SaaS) model of
BillQuick desktop that is hosted by us.

e It provides you with a secure, hassle-free, investment-free time tracking,
billing, project management and accounting software.
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It not only stores data solely at the hosted site (called ‘cloud’) but also at
your local site. If you have been using BillQuick desktop on a computer or
laptop, whenever Internet connection is available, you can sync that data with
the BillQuick Online database using the synchronization tool.

You do not have to worry about backups. Data backups are automatically
taken by us.

.
'.9_,'1-0 learn more about BillQuick Online, please check out the BillQuick Online
Help. In addition, check out www.BillQuickOnline.com.

Web Suite- browser-based version of BillQuick

It allows you to access BillQuick through a web browser, via your local
company network/server, an Intranet or Internet.

It is useful for companies with satellite offices or with staff, managers or
consultants who work remotely.

Some companies also deploy Web Suite inside their company to cut the total
cost of ownership.

It allows you to track time and expenses, bill your clients and generate
reports anywhere, anytime.

Security and other settings in BillQuick carry to Web Suite, but you can
overwrite them to suit your needs.

.

I'Q-f'To learn more about Web Suite, please check out the Web Suite Help. In
addition, see the Web Suite Getting Started Guide for installation instructions
and main procedures.

BillQuick Mobile—mobile app for BillQuick

It can be downloaded and accessed on iPhones, Android phones and Windows
phones.

It allows you to quickly enter time and expenses from your smartphones.
Data can be entered even without wireless or data connectivity.

It syncs all your entries seamlessly with the server.

BillQuick Agent—workflow automation tool

It allows time-sheet and expense sheet monitoring. Agent checks employee
and subcontractor time-cards and expense log daily or weekly to make sure
they record their hours according to company policy. It sends email reminders
to delinquent timekeepers and their supervisors.

It schedules any standard or custom report in BillQuick for automatic
generation and delivery to anyone inside or outside the firm via email or on-
screen. You can also print reports.

It is useful for setting up and generating business alerts. Agent automatically
tracks the changes in the database that signal a special situation or an event
that requires your immediate attention. It then sends an email or instant
message to your BillQuick desktop.
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.
I‘Q-f'To learn more about Agent, please check out BillQuick Agent Getting
Started Guide for installation instructions and main procedures.

BillQuick Outlook Add-In—integration with Microsoft Outlook

e Outlook Add-In is embedded in Microsoft Outlook and captures time from
appointments, tasks and emails.

e It allows you to send Outlook data to BillQuick such as tasks and
appointments.

e It allows you to exchange contacts between BillQuick and Microsoft Outlook.

.

I‘Q-f'To learn more about Outlook Add-In, please check out BillQuick Outlook
Add-In Getting Started Guide for installation instructions and main
procedures.

BillQuick HR - management of employees

e It enables you to manage your employees and fulfill the associated human
and legal obligations.

e You can maintain employee profiles, track employee benefits, incidents and
vacation time, conduct performance reviews, generate related reports and
much more.

e You can import employees from BillQuick and exchange data with BillQuick
without any special setup.

.
I‘Q-f'To learn more about BillQuick HR, please check out BillQuick HR Getting
Started Guide for installation instructions and main procedures.

BILLQUICK SERVICES

To maximize the productivity of your in-house resources, BillQuick recommends following
your initial purchase with an assessment of your unique training and deployment needs. Our
experts bring over a decade of expertise and proven best practices to ensure your BillQuick
deployment works smoothly.

Involving BillQuick professional services early in your deployment can dramatically reduce
cost by helping to shape efficient organizational processes that proactively accelerate your
key business functions. Our training services empower your employees to make the most of
your BillQuick investment. We can even customize a program just for you.

Deployment Services

Our deployment services are designed to assist in the initial deployment, complementing
your existing resources and accounting software packages, covering primary installation and
configuration of BillQuick software and add-ons in your specific environment. We get your
new time tracking and project management system operational cost-effectively and your
staff up to speed rapidly.
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Customization Services

Enhancement and customization services extend and tailor the core functionality of the
BillQuick platform to address specific customer needs and requirements. Need a report for a
specific client? Perhaps you have a wide range of customers, each with their own invoice
and billing requirements. We can get you up and running with custom reports, statements
and other documents tailored to your business. BQE guarantees that a custom invoice or
report will work with future versions of BillQuick. You can call 888-245-5669 for a free
business needs assessment or quote.

Training Services

BQE Software offers various online and on-site training courses. These trainings help you to
maximize your investment in BillQuick and bring your staff up-to-speed on various aspects
of BillQuick, such as timekeeping, billing, data integration, and more. Our certified trainers
can help you with installation, setup and configuration of BillQuick according to your
company needs and preferences.

Consulting Services

BQE Software offers professional consulting services to help our new and existing customers
install, implement and deploy our products in a cost-effective and professional manner. Our
Consulting Service is designed with a 'single point of contact' model that allows our
customers to work with a dedicated BQE Analyst throughout the consulting process.

' See BillQuick Services for more.

BillQuick Help

HELP OVERVIEW

Navigation Help menu, Contents

When you buy a software program, you want to know what the program offers, how it
benefits you and how to use it in the simplest and fastest way possible. The BillQuick Help
meets these expectations by covering all the features and functionality of BillQuick at the
basic level (for the first-time users) as well as at the advanced level (for existing users). It
answers all your important questions —What is this?, What does it do? and How do I do it?’

The BillQuick Help is organized into books and topics covering everything about a feature or
screen in the form of Understanding topics (explanation of concepts), Overview
(introduction of screen), Reference Information (description of fields and options on screen),
and How Do I (procedure to do a task).

You have access to many help and support options in BillQuick.

a—
e You can access the in-context BillQuick Help by clicking the "Q/'Help button on the
screens. You can also press F1 in any screen or dialog box to access the Help.

e You can access various help and other support resources from the main Help menu.
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e You can access our website www.bge.com and search through our online Knowledge
Base, e-Letter Archives, FAQs or Support Documents. It also provides information on
other products, services and business solutions.

e You can contact our Technical Support to get answers to specific questions at 310-
602-4030 or Support@bge.com.

e You can undergo standard or customized one-on-one training courses. BillQuick
Certified Trainers can train you on using BillQuick and add-on modules. Check out
the Training Services at (310) 602-4020 or www.bge.com/Services.

e BQE also offers professional Consulting Services to help you install, implement and
deploy our products in a cost-effective and professional manner. Find more at (310)
602-4020 or www.bge.com/Services.

e You can use our Report Customization Services to efficiently develop custom reports
and invoice templates for you according to your specifications. Find out more at
(310) 602-4020 or www.bge.com/Services.

e You can use our premium services to get exclusive consultation and assistance on
implementing and optimizing BillQuick in your organization. Find out more about our
Promise Package, Productivity Package and Implementation Kits.

Help File Conventions

The BillQuick Help follows some presentation conventions, making it easier and faster for
you to scan and review information. Most of the topics have been organized into four parts:

Understanding: giving a comprehensive overview of the concepts and features.
Overview: giving a general introduction to the feature or screen.

Reference Information: providing descriptions of field names and options on screen.
How Do I: providing step-by-step instructions or procedures for performing a task.

Other conventions employed in the BillQuick Help include:

. _Item _________________ __ Presentation |

Field Name Initial cap for each word,
Field Group Name Bold text
TOPIC TITLE All caps for each word,
Bold text
Minor emphasis Italics
Significant emphasis Italics and bold text
Special information or ﬂ
notes Callout within topic
. —
Help Information @ caiiout within topic
Warnings and caution &Callout within text
Buttons and icons Initial capital for each word,
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within text/sentences
Each menu item is separated with a comma.
For example, ‘Project menu, Document
Management’ means to select the Project
menu and then choose Document
Management from it.
Key begins with a capital letter. For example,
Shift, Ctrl, <Tab>
‘Click” means to mouse over the item and
Reference to selecting an | press the left mouse button. Click and another

Reference selection from a
menu

Keys on the keyboard

icon or button action or keystroke uses a plus sign. For
example, Ctrl+click
Hyperlinks Click link to jump to the topic or web page
Navigation Click to find the _Iocat_ion of a screen in
BillQuick

.

I'Q-f'Your feedback helps us plan and improve BillQuick releases and associated
documentation. Please email your comments, suggestions and ideas about BillQuick and its
Help to BQ-Ideas@bge.com.

How Do 1

HOW DO I ACCESS HELP?

Your BillQuick program comes with an in-context or context-sensitive help file. To access
the BillQuick Help, you can choose any of the following options:

To access the main help:

1. From the Help menu, select Contents.
2. Use the tabs, buttons and links to navigate the help file.

To access the context-sensitive (in-context) help:

1. Click the Help button on any screen or dialog box. Else, press F1.

HOW DO I USE THE HELP?

The BillQuick Help provides detailed procedures, reference information, tips, and links to
resources that answer your questions or clear your doubts. For assistance while you work,
click the Help button on any BillQuick screen or use the Help menu.

The main Help information can be accessed from the Contents tab, which organizes topics

into books (9) and pages (), allowing you to understand and choose the desired topics.
The table of contents displayed on the left allows you to understand the hierarchy of
information and also the relationship between features. It displays a tree-like structure. To
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expand a book and reveal its pages, you must click or the book name itself. To collapse

a book and hide its pages, click = or the book name itself.

The Index tab provides a predefined list of keywords and their topics. You can choose a
keyword and click Display to jump to that help topic. The Search tab allows you to search
for help topics by your own keywords.

In the BillQuick Help file, do the following:

. cick . To |

View the table of contents for the Help. Click each
book to display pages under it that link to related

Contents topics. Click each page to display the
corresponding topic in the right pane.
Search for specific words or phrases or select
Index from a list of index keywords. Choose a keyword

and click Display to view the corresponding topic
in the right pane.
Locate words or phrases within the content of
your topics and type those in the text field. Click
Search List Topics and select the topic you want to view
from the list. Then click Display to view the
corresponding topic in the right pane.

When viewing information in one topic you can easily look up a word by pressing Ctri+F
keys simultaneously on your keyboard. This opens up a dialog box, where you can search
for a specific word.

HOW DO I PRINT HELP?

You can print BillQuick Help topics right from the Help screen. Else, you can use and print
the BillQuick Help Manual.

To print a Help topic:

1. Open the BillQuick Help and locate the topic you want to print.

2. Right-click in the right pane and select Print. Else, use the Print option on the button
panel.

3. The Print Topics dialog box opens. It prompts you to print either the selected topic or
all the topics and sub-topics under that book/heading. Click OK.

4. 1In the Print screen, select the desired printer. You can choose to print the Help on
paper or as a PDF.

5. Click Print. The topic is printed to the specified printer (paper or PDF).

CONTACT INFO

BQE Software, Inc. is a California based C Corporation, founded in 1995. It first introduced
its flagship product, BillQuick, in May 1996 and since then BQE has developed a host of
programs and solutions for your specific needs.
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You can contact us for information about the latest products and services; ordering
products; training and consulting; technical support; report customization or any other
business query.

Corporate Office

Address: BQE Software

3825 Del Amo Blvd.
Torrance, CA 90503

USA
Telephone: +1 (310) 602-4010
Fax: (310) 784-8482
Office Hours: Monday to Friday
8 AM to 5 PM Pacific Standard Time
Website: www.bge.com
BQE Blog: blog.bge.com
User Forum: BillQuick Yahoo Group
Services: www.bge.com/Services
Sales

Contact our sales representative for information about the latest products and services.

Telephone: 1 (855) 237-1238 (Within USA)
+1 310-602-4020 (Outside USA)

Website: www.bge.com

Email: sales@bge.com

Technical Support

For technical support, you can contact our Support Team. Before you call, email or fax us,
please provide the following information for the fastest possible service:

Product serial number (registration number)

Your name, company name and phone number

Exact product name and version number (To find the version of BillQuick, click Help,
About BillQuick)

e Type of operating system (say, Windows XP)
e Complete description of the issue, including steps to reproduce it
e Exact wording of any messages displayed when you encountered the problem
e Steps taken to resolve the problem
e All previous email threads with BQE Software about the issue, if any
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Telephone:

+1 (310) 602-4030

Knowledge Base:

kb.bge.com

Email: support@bge.com
Website: www.bge.com/Support
Hours: 7 AM to 3 PM Pacific Standard Time

Australia Office

Address:

BQE Software

255 Broadway Suite 7
Glebe, N.S.W 2037
Australia

Telephone:

1300-245-566
+61 (02) 9249 7327 (Outside Australia)

Fax:

+61 02-8323-4615

Sales Hours:

Monday to Friday
8:30 AM to 5:30 PM Eastern Time

Website:

www.bge.com.au

Email:

aus-Support@bge.com

aus-sales@bge.com

Support Hours:

Monday to Friday
8:30 AM to 5:30 PM Australian Eastern
Standard Time

Europe Office

Address: BQE Software
Crosshaven Co. Cork
Ireland
Telephone: +44 20 3411 9852
+353 76 603 2047 (From Ireland)
+358 92 316 3286 (From Finland)
Website: www.bge.co.uk
Email: uk-support@bge.com

uk-sales@bge.com
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START-UP

Installation

INSTALLATION OVERVIEW

A BillQuick Supervisor is responsible for planning and implementing the initial setup and
deployment of BillQuick. You should follow a plan, ideally a written plan, to ensure all
preliminary and necessary tasks are completed and checked off (see Appendix). Please read
the BillQuick Getting Started Guide for the installation details.

S
"9/' Before installing the software, please read the End User License Agreement (EULA).

You can see the basic installation steps in the below flowchart. Click on the desired areas of
the image for more.
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BillQuick Startup

Download Setup
from Website

Run the Installer (Wizard)

Open BillQuick

Welcome to BillQuick Dialog

;

New Database

Standard

BillQuick Standard
Database Dialog

BillQuick SQL
Database Dialog

BillQuick Startup Interview

BillQuick Initial Setup
Checklist Wizard

Sample Database

Existing Database

Standard

Update Database

Connect to New Version
(Upgrade Data)

Copy Custom Reports &
Invoices to New Location

17 New User/New Database J

Company Setup

Master Information Setup

BILLQUICK COMPANY FILE OPTIONS

Product Activation

Existing User/Existing Database

New User/Sample Database ‘l
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If you have previously used BillQuick on your machine, it will automatically open the last
used database. The first time you start BillQuick, it will prompt you to select a company file
and database type. Creation of BillQuick database requires system administrative privileges.
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Typically, a BillQuick Supervisor (or an IT administrator) handles this task and then informs
the other users about its location, User ID and Password (if applicable).

o Create a New Company File
You can create a new company file in either a Standard database (Microsoft Access)
or SQL database (Microsoft SQL Server Express or SQL Server Standard). Your
options depend on which edition of BillQuick you purchase: Basic, Pro or Enterprise.
Database name can be different from Company Name.

9When creating a new company, enter the Company name exactly as it appears
on the email containing the license and registration keys.

e Open a Sample Company File
You can select any of the sample industry-specific databases available. Select the
desired option from the Your Business Type drop-down list. The options include
Service, Architectural, Accounting, Consulting, Engineering and Legal samples.
Depending upon your selection, you will have customized labels and lexicon available
in BillQuick.

e Open an Existing Company File

You can select an existing BillQuick database. Choose the type of database and then
open an existing database from the Open dialog box to proceed further.

.
"9/' Read the BillQuick Getting Started Guide for procedures and details.

Button Panel

Help:
Opens the BillQuick Help in the BillQuick Company File Options section.

Cancel:
Closes the screen and the BillQuick program.

SQL DATABASE

SQL DATABASE OVERVIEW

Over time, most database applications grow, become more complex and need to support
more users. At some point in the life of your BillQuick database, consider upsizing to
Microsoft SQL Server Standard or SQL Server Express to optimize database and application
performance, scalability, security, reliability, recoverability and availability. SQL Server is
capable of handling hundreds of concurrent users and growing databases to sizes beyond 1
terabyte (TB). Upsizing to SQL Server can fulfill scalability needs without necessitating
costly and time-consuming changes to existing programs. All BillQuick editions support and
use the Microsoft Access database while as BillQuick Enterprise uses Microsoft SQL Server
Standard. When upsizing to a SQL Server database or when upgrading to a higher version,
BillQuick security settings are transferred to the new database.

General guidelines for database selection are:
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| Users | BillQuick Edition Recommended Database

210 4 BillQuick Basic Microsoft Access/Standard
Microsoft SQL Server Express
5 to 50 BillQuick Pro Microsoft Access/Standard

Microsoft SQL Server Express

Microsoft Access/Standard
50 or more  BillQuick Enterprise Microsoft SQL Server Express
Microsoft SQL Server Standard

e High Performance and Scalability
In many situations, Microsoft SQL Server offers better performance than the
Microsoft Jet engine. SQL Server also provides support for very large databases,
which is much larger than the current limit for an MDB database of 2 GB
(gigabytes). Finally, SQL Server works very efficiently on Microsoft Windows NT by
processing queries in parallel (using multiple native threads within a single process
to handle user requests) and minimizing additional memory requirements when
more users are added.

e Increased Availability
Using Microsoft SQL Server Standard, you can do a dynamic backup, either
incremental or complete, of the database while it is in use. Consequently, you do
not have to force users to close the database to back up data. This means your
database can be running up to 24 hours a day, 7 days a week.

e Improved Security
Microsoft SQL Server Standard can integrate with the Windows NT operating
system security to provide a single logon to the network and database. This makes
it much easier for you to administer complex security schemes. The SQL Server
Standard database on a server is also better protected because unauthorized users
can't get to the database directly but must first access the server.

e Immediate Recoverability
In case of system failure (such as an operating system crash or power outage),
Microsoft SQL Server Standard has an automatic recovery mechanism that
recovers a database to the last state of consistency in a matter of minutes, with no
database administrator intervention. Critical programs can be up and running again
within no time.

e Reliable Distributed Data and Transactions
Transaction processing is a vital requirement for a system that is designed to
support critical programs, such as BillQuick. Microsoft SQL Server Standard
supports atomic transactions with transaction logging, which guarantees that all
changes performed within a transaction are either committed or rolled back.

Consistency and recoverability of a database transaction are guaranteed even in
the case of system failure and in the middle of complex updates by more than one
user. SQL Server Standard treats all database changes inside a transaction as a
single unit of work. By definition, either an entire transaction is completed safely
and all resulting changes are reflected in the database, or the transaction is rolled
back and all changes to the database are undone. Using a two-phase commit
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protocol, SQL Server Standard can even support synced transactions that span
more than one server ensuring that all servers on the network are maintained in a
consistent state.

e Server-based Processing
Microsoft designed SQL Server Standard as a client-server database. Data and
indexes reside on a single server computer that is often accessed over the network
by many client computers. SQL Server Standard reduces network traffic by
processing database queries on the server before sending results to the client.
Thus, your client-server application can do processing where it's done best—on the
server.

SQL SERVER EXPRESS DATABASE

Microsoft SQL Server Express is the freely-downloadable and distributable version of
Microsoft SQL relational database management system. It offers a database solution
specifically targeted for embedded and smaller-scale programs. Unlike its predecessor,
MSDE, there is no concurrent workload governor which limits performance if the database
engine receives more work than is typical of a small number of users. It does, however,
have a number of technical restrictions, which make it undesirable for large-scale
deployments, including:

¢ Maximum database size of 4 GB (compared with 2 GB for MSDE). The 4 GB limit is
per database (log files excluded) and can be extended in some scenarios through the
use of multiple interconnected databases.
e Hardware utilization limits:
e Single physical CPU, multiple cores
e 1 GB RAM (runs on any size RAM system but uses only 1 GB)
e Absence of SQL Server Agent Service

Although its predecessor MSDE was virtually devoid of basic GUI management tools, SQL
Server Express includes several GUI tools for database management. Among these tools
are:

- SQL Server Management Studio Express

- SQL Server Configuration Manager

- SQL Server Surface Area Configuration tool

- SQL Server Business Intelligence Development Studio

A relatively late addition to the SQL Server Express product line is a reduced functionality
version of SQL Server Reporting Services but features such as Analysis Services, Integration
Services and Notification Services are only available in the Standard and higher editions.

ﬂBQE Software offers professional consulting services to help our new and existing
customers install, implement and deploy our products in a cost-effective and professional
manner. Our Consulting Service is designed with a 'single point of contact' model that allows
our customers to work with a dedicated BillQuick Consultant throughout the consulting
process.
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System Requirements for SQL Server Express

Software Requirements
e Microsoft .NET Framework 2.0
e SQL Server Setup requires Microsoft Data Access Components (MDAC) 2.8 SP1 or
later. You can download MDAC 2.8 SP1 from Microsoft website.
e Microsoft Internet Explorer 6.0 SP1 or later (prerequisite for .NET Framework)

Hardware Requirements
e 1 GB RAM (2 GB or higher recommended)
e 1 GB free hard disk space
e Pentium 4 Compatible or higher processor (2 GHz or higher)

Operating System Requirements
e Windows Server 2003
e Windows Small Business Server 2003
e Windows XP/Windows Vista/Windows 7

Installation

SQL Server Express runs as a service on the machine where it is installed. It only needs to
be installed once as the service can host multiple databases from different programs.

You can create a new SQL Server Express database in BillQuick from the File menu, New
Company. You must enter the Server Name, User ID (system administrator), Password and
Database Name. For details on SQL Server Express installations, please read these guides:

BillQuick-SQL-Server-2008-Express-Installation-Guide
BillQuick-SQL-Server-2012-Express-Installation-Guide

.
"9/' You can also get BillQuick professionals to install BillQuick for you. Please check our
Deployment Services for more information.

SQL Server Standard

SQL SERVER STANDARD DATABASE

SQL Server Standard is a client-server database management system. Unlike file-based
databases, client-server database engines manage read/write operations for the database.
Because of this, client-server databases such as SQL Server Standard can handle more
concurrent users and greater amounts of data. SQL Server Standard is designed to meet
the most demanding database application requirements for the enterprise, including
operational and decision support systems implemented today and in the future. SQL Server
Standard is offered in different editions based upon data, user and hardware requirements.
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ﬁSQL Server Standard supports BillQuick Enterprise edition only.

Specifications of SQL Server Standard Database
e Creates primary database using primary file path of master database
Database size = 100 MB
File growth = 5 MB
Creates database primary file with same name as database with an extension .mdf
Creates database transaction log file with same name with an extension .Idf
Log file size = 10 MB
Growth = 2 MB
Creates archive database using primary file path of master database
Archive database has same name as the primary database with an extension .ark
Archive database creates the database and transaction log files with the same
settings. File names have an extension .ark

You can create a new SQL Server Standard database from the File menu, New Company.
The BillQuick SQL Database screen displays where you must enter the Server Name, User
ID (system administrator), Password and Database Name. You can check the Use Windows
Authentication option to log in via the Windows authentication mode (see Log In and
Authentication for details).

Testing Connectivity to SQL Server Standard

An ODBC System data source stores information about how to connect to a data provider.
You can use the ODBC Administrator to test connectivity to SQL Server Standard. Follow
these steps to do so:

1. Open your ODBC Data Source Administrator (Control Panel, ODBC data sources).

2. Go to the System DSN tab and click Add.

3. On the wizard, select SQL Server driver and click Finish.

4. Enter a Name for the data source name, Description and SQL Server to which you
want to connect.

5. Select the option 'With SQL Server authentication using a login ID and password

entered by you'.

6. Click on Client Configuration. Select TCP/IP network libraries.

7. Dynamically determine port and select Server Alias and Server Name. Try using
TCP/IP. Click Next.

8. Select the default database and click Next.

9. Click Finish. A dialog box appears displaying some settings.

10. Click Test Data Source. If it displays 'Tests Completed Successfully!', your machine is
able to see the SQL Server.

Backup

BillQuick Enterprise only handles backup for a Microsoft Access database. For SQL Server
databases, this feature is more efficiently handled using the SQL Server backup tool. You
can use it to have complete, or differential and scheduled backups.

ﬁMake sure you back up both the primary database and archive database.
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SYSTEM REQUIREMENTS FOR BILLQUICK ENTERPRISE (SQL SERVER STANDARD)

Over time, most database applications grow, become more complex and need to support
more users. At some point in the life of your BillQuick database, consider upsizing to
Microsoft SQL Server Standard or SQL Server Express to optimize database and application
performance, scalability, security, reliability, recoverability and availability. To do so, ensure
you meet the system requirements:

Server Requirements

e Microsoft SQL Server Standard (2005 or later) with latest service pack installed
Microsoft Windows (2008 or later) server with latest service pack installed
Network Connectivity to SQL Server Standard using a 100/1000 Mbps network
10 GB of free hard disk space*
SQL System Administrator User ID and Password

*Creating a new database requires a minimum of 100 MB of free disk space. When upsizing
an existing BillQuick database, you should have twice as much free space on SQL Server
Standard/Express compared with the size of your BillQuick (.mdb) database.

Client Requirements

Windows 7 or better (with latest service pack installed)

2 GB RAM (4 GB recommended)

10 GB of free hard disk space

Permission to log in as an administrator

Network Connectivity to SQL Server Standard/Express via TCP/IP or named pipes
3 GHz processor or faster

SQL LOGIN AND AUTHENTICATION

Log In

Login IDs are the account identifiers that control access to any SQL Server Standard
system. SQL Server Standard will not complete a connection unless it has first verified that
the login ID you entered is valid. This verification of the login is called authentication. When
BillQuick Enterprise creates or up-sizes the database on the SQL Server, two log-ins are
created in the SQL Server:

e BillQuickSQL with password admin
e BillQuickGuest with password Guest

The above login names are also assigned as BillQuick database users. The BillQuickGuest
user has read-only access to the database and can access only the BillQuick settings table
(BQS Table). This user has only a public database role. The BillQuickSQL user has a public
and a db-owner database role. This user can perform all the operations on the database
that it owns.

When you open the BillQuick database on the SQL Server, you can log in as BillQuickSQL
and use the default password 'admin’. If the password does not match or is incorrect, it gets
the password from BQS Table by logging in as BillQuickGuest. If the stored password fails,
you are prompted to enter the correct password. You can change the password of
BillQuickSQL user in the BillQuick program from Global Settings (Settings menu). You
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should also provide the system administrator name and password. It is very important that
no one deletes or changes these two log-ins and their privileges. If deleted, the program will
not be able to connect to the database.

BillQuick allows you to connect to SQL Server Standard via Windows Authentication (also
called as Trusted Connection). Using this mode, client application establishes the connection
to the SQL Server Standard using the Windows Logon credentials (that is, Windows User
and Password). The Windows Logon credentials are automatically passed to SQL Server
Standard for authentication. SQL Server Standard allows any client application to connect to
the server and database via two different modes:

e SQL Server Authentication Mode/Standard Security
A member of the sysadmin fixed server role first specifies all the valid SQL Server
login accounts and passwords to SQL Server Standard. These are not related to your
Microsoft Windows account or network account. You must supply both the SQL
Server Standard login and password when you connect to SQL Server Standard. You
are identified in SQL Server Standard by your SQL Server login.

e Windows Authentication Mode/Trusted Connection
A member of the SQL Server sysadmin fixed server role must first specify to SQL
Server Standard all the Microsoft Windows NT® accounts or groups that can connect
to SQL Server. When using Windows NT Authentication, you do not have to specify a
login ID or password when you connect to SQL Server. Your access to SQL Server is
controlled by your Windows NT account or group, which is authenticated when you
log on to the Windows operating system on the client machine. When connecting, the
SQL Server client software requests a Windows trusted connection to SQL Server.

Windows NT will not open a trusted connection unless the client has logged on
successfully using a valid Windows NT account. The properties of a trusted
connection include the Windows NT group and user accounts of the client that
opened the connection. Because it is impossible for a trusted connection to be
completed without Windows NT having first authenticated the user, SQL Server does
not have to do anything to authenticate your accounts. SQL Server gets the user
account information from the trusted connection properties and matches them
against the Windows NT accounts defined as valid SQL Server log-ins. If SQL Server
finds a match, it accepts the connection. Your Windows NT group or user account
identifies you on SQL Server.

When SQL Server Standard is running on Windows NT, members of the sysadmin fixed
server role can specify one of the two authentication modes:

¢ Windows NT Authentication Mode: Only Windows NT Authentication is allowed.
Users cannot specify a SQL Server login ID.

e Mixed Mode: If you supply a SQL Server login ID when connecting, it is
authenticated using SQL Server Authentication. If you do not supply a SQL Server
login ID, it is authenticated using Windows NT Authentication.

These modes are specified during setup or with SQL Server Enterprise Manager. The
Windows 95/98 operating system does not support the server side of the trusted connection
API. When SQL Server Standard is running on Windows 95/98, it does not support Windows

BillQuick | Power Up Your Business 61
(866) 945-1595 | www.bge.com | info@bge.com


http://www.bqe.com/
mailto:info@bqe.com

(bqe BillQuick HELP MANUAL

NT Authentication. Every user must supply a SQL Server login when they connect. When
SQL Server is running on Windows NT, Windows 95/98 clients can connect to it using
Windows NT Authentication.

One of the properties of a login is the default database. When a login connects to SQL
Server Standard, this default database becomes the current database for the connection,
unless the connection request specifies that another database be made the current
database. For any query, please contact support.microsoft.com

We can save the credential settings for SQL login in a file using 'Save Settings to' option.
You can browse to a location and save the file to that location. You can use this anytime by
using the 'Load from a file' hyperlink on the screen.

How Do I

HOW DO I INSTALL BILLQUICK ON A NETWORK?

Please read the BillQuick Getting Started Guide for this information. You can also get our
BQE professionals to install BillQuick for you. Please check our Deployment Services for
that.

HOW DO I UPGRADE BILLQUICK?

If you are an existing BillQuick user, you can upgrade to the new BillQuick 2016 version.
Before you begin the upgrade process, you must download and install BillQuick 2016 (see
the BillQuick Getting Started Guide for details or click BQE Product Overview).

ﬂFor instructions on how to upgrade your old version of BillQuick to the new BillQuick
2016 version, please read the Upgrade to BillQuick 2016 whitepaper.

HOW DO I CREATE A NEW COMPANY DATABASE?

The first time you start BillQuick, it will prompt you to select a company file and database
type.

1. Click on 'Create a New Company File' option.

2. Select the correct database option. (To choose SQL, make sure you have already
installed and configured a SQL Server Standard/Express database.)

3. Navigate to the folder where you want to store your company database. If you are in
a network environment, this should be a shared folder. Place this file in a safe
location such as My Documents.

4. Enter a name for your BillQuick company database and click Open.

5. You will receive a message confirming the successful creation of your database.
Clicking OK will open the BillQuick Start-Up Interview wizard.
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6. You can skip it or step through it without worrying about your selections. You can
change them later. Click Finish and close.

ﬂIn specific situations, you might have to close the BillQuick database connection for a
logged-in user. For example, If a user is logged into BillQuick for more than 48 hours, use
the 'Force Close DB Connection' option (from Utilities menu) to force the BillQuick
connection to close.

After you have created the company database, you need to add master information to it.
You can do so from the wizards or manually from the screens. See the Company Setup
Checklist in the Appendix section for more.

I'ﬁ'For detailed procedures, check out the BillQuick Getting Started Guide.

HOW DO I GET STARTED IN BILLQUICK?

When you start BillQuick for the first time, the security feature is automatically turned on.
Use the default User ID and Password, Supervisor, to log in. The first thing you should do is
to create a new database for your company. After creating a new database, you can add
your company information in the following way:

1. When you create a new database, it prompts you with a BillQuick Start-Up Interview.
Else, select it from the View menu or Sidebar.

2. On the BillQuick Start-Up Interview screen, click Next.

3. On the Business Type screen, choose your industry type, such as Business
Consultant, Accounting, Computer Programming, etc. BillQuick copies industry-
specific activity (service) and expense codes into your company database. Click Next.

4. Custom Labels allow you to change key business terms to suit your professional and
company preferences in BillQuick. Select your preferred terms from the drop-down
lists, such as Customer instead of Clients, Jobs instead of projects and so on. When
you have finished, click Next.

5. On the Company Name page, enter your company name. Spell it exactly as it
appears in your License and Registration email.

6. Click Next to accept the defaults on the remainder of the wizard. You can update
these options later in the Global Settings and User Preferences screen. On the last
page, click Finish.

7. The BillQuick Initial Setup Checklist screen displays. It enables the first time user to
create master information (employee, client, project, activity, etc.) by clicking on the
relevant option.

8. If you have older or historical balances from a manual system or software accounting
system, you need to enter the opening balances to use the accounting features. To
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enter project specific balances, use the Opening Balances option on the Project-
History screen.

9. When you are done, click Close.
We recommend that you enter the master information in the following order:

1. Company information
2. Employee information
3. Vendor information
4. Activity Codes

5. Expense Codes
6. Client information
7. Project information
8. Service Fee Schedule
9
1

. Expense Fee Schedule
0. Budget/Estimate

You can do so from the wizards or manually from the respective screens. See the Company
Setup Checklist in the Appendix section for more.

HOW DO I UPSIZE TO SQL DATABASE?

For better performance, SQL Server Express database can be scaled up to SQL Server
Standard without code modifications. BillQuick includes a tool to convert your Microsoft
Access database to Microsoft SQL but requires a new license key. All editions of SQL Server
7.0 can be upgraded from an existing MSDE solution. Another way to upgrade an MSDE
solution is to use SQL Server 7.0 Enterprise Manager from a SQL Server machine to connect
to the MSDE. After connecting, data can be transferred from the MSDE installation to SQL
Server. This is a good method when upgrading to SQL Server Standard using a different
machine.

.

"9/' If you are not comfortable installing and configuring SQL on the server or computer, a
BQE Consultant can help you for a nominal fee. Please contact BQE sales at (888) 245-5669
(outside USA +1 (310) 602-4020) or check our Consulting Services for more information.

Prior to upsizing your BillQuick database to SQL, please do the following:

e Back up your database. Although the wizards do not remove any data or database
objects from your Access database, it is a good idea to create a backup of your
BillQuick database prior to upsizing.

e Ensure you have adequate disk space. You must have adequate disk space that will
contain the up-sized SQL Server Standard database. The upsizing wizard works best
when there is plenty of disk space. Multiply the size of your BillQuick database by
two and reserve that amount of space on your SQL Server. This ensures enough
space to upsize your database and also gives it some room to grow. If you expect to
add a lot of data to the database, make the multiplier a larger number.
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9If the upsizing wizard runs out of disk space on the server, the process stops, leaving a
partial database created on the server. If this happens, you can drop (delete) databases and
tables using Microsoft SQL Server Enterprise Manager.

To upsize to BillQuick Enterprise:

1. After installing Microsoft SQL and BillQuick Enterprise, open your existing BillQuick
2016 database.

2. From the File menu, select 'Upsize to SQL Server'.

3. In the BillQuick SQL Database screen, enter the SQL Server Name, User ID,
Password and Database Name of the new BillQuick Enterprise database. The User ID
must have system administrative (SA) rights on the SQL Server.

4. Enter or browse for the location where these SQL database settings will be saved.
Click OK.

5. A progress bar and message indicates the upsizing activity. You will receive
messages if the connection is not established. Sometimes, due to slow network
speed or server, the upsizing might not be successful. If so, use SQL Server
Enterprise Manager to delete the database and try again.

Upon completion, BillQuick creates a log file (bgsglerr.txt) containing the details of the
success events and errors encountered during the upsizing process. Please review the file to
determine the severity of the errors.

HOW DO I UPDATE BILLQUICK?

When you purchase BillQuick, periodic updates containing minor improvements, software
updates, service packs, and new features are available free. A secure connection protects
client-sensitive information during an update. Under no circumstances do BillQuick servers
access or read any information on your computer. During an update, BillQuick downloads
only the necessary files to your system.

To update your BillQuick software:

1. If you have an Internet connection on your computer, BillQuick automatically checks
for an update each time you start it. If a new update is available, it prompts you to
download the update. You can disable automatic updates on the User Preferences-
Options screen. When disabled, you must manually check for updates using the Help
menu, Get Updates option.

2. You can view the download size and the detailed list of changes made in the update.
Click on the link provided to read the associated log file (Release Notes). Else, click
the Download button to start the download.

3. After BillQuick downloads an update, it prompts you to install it. Click Yes to do so.
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9You or a system or network administrator can install the update by running the latest
BQUpdate.exe program on each workstation.

LICENSE & REGISTRATION

LICENSE AND REGISTRATION OVERVIEW

On installation, BillQuick can run in evaluation mode for 7 days. After that, you need to
activate the product by applying the license and registration keys to it or using it for a 15-
day evaluation period. Licensed and evaluation software can run together. You can choose
to subscribe to BillQuick by clicking the 'I am Ready to Buy' option on the Product Activation
screen.

License keys determine the number of unique login IDs or subscribed users that can access
BillQuick. Besides the license keys, you also need to apply for the registration keys to
continue using BillQuick on each workstation or computer. Both the license and registration
keys are provided to you when you subscribe to BillQuick.

You can apply the license and registration keys via any of the following:
e Product Activation screen

e Company-License screen
e Product Licensing and User Management screen

ﬂPIease store the License and Registration Keys for BillQuick and its add-on
modules in a secure location.

Fa—
I'k-af'PIease see the BillQuick Getting Started Guide for more.

PRODUCT ACTIVATION

When you start BillQuick and it is either not yet activated or in the evaluation mode, the
Product Activation screen displays. For continued use of BillQuick in evaluation mode,
activation is required. Else, you can just subscribe to it for unlimited use. In a network
environment, this task can be performed from any computer on which BillQuick is installed.

The Product Activation screen provides four options.

e Activate Now
If you want to evaluate BillQuick before making your subscription decision, you can
use BillQuick in the evaluation mode by clicking on Activate Now option. You will be
asked to enter your company name, address, phone number and email address.
After you have finished, the evaluation key will be sent to you. You can get the free
evaluation key via email/phone/Internet.

You can continue to use BillQuick in evaluation mode for a period of 15 days and
after the expiry of that period, BillQuick program is locked. After 15 days, the
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database must be licensed and BillQuick must be registered for further use. For more
information, call (310) 602-4020 or visit www.bge.com.

e Activate Later
You have an option to activate the BillQuick program in order to start the 15-day
evaluation period. Else, you can activate the product later. Activating the product
later starts a 7-day activation period during which the product can be activated for
15-days or subscribed to for unlimited use.

e I am Ready to Buy
This option takes you to the BQE website where you can purchase the license and
registration keys for BillQuick. You can also purchase the keys by calling 310-602-
4020 or emailing sales@bge.com.

The license key is based on your company name, and hence, if you change your
company name or the number of authorized users, a new key must be obtained.
Registration is based on product code and hence to be done once per user.

e Already Purchased
If you have already subscribed to BillQuick, enter the exact License Key and
Registration Key provided to you. The license key is based on your company name,
and hence, if you change your company name or the number of authorized users, a
new key must be obtained. Registration is based on product code and hence to be
done once per user.

"9/' Read the BillQuick Getting Started Guide for procedures and details.

PRODUCT LICENSING & USER MANAGEMENT

PRODUCT LICENSING & USER MANAGEMENT OVERVIEW

Navigation File menu, Licensing and User Management

BillQuick offers various options for licensing and registering your copy of BillQuick. You can
use the Product Activation, Company, or Product Licensing and User Management screen to
do that.

Product Licensing and User Management Console allows you to manage the licensing and
user authorization of BQE products and add-ons. The purpose of this screen is to provide a
common platform for all the BQE Software products from where authorized people can
assign/un-assign users and obtain other licensing information. This screen is accessible from
BillQuick and its add-ons. It has two tabs—Licenses and Users.

You must subscribe to BillQuick by purchasing the relevant license key and installing it using
any of these screens. The License Key is based on your company name and, hence, if you
change your company name or the number of authorized users, a new license key must be
obtained. Registration is based on product code and hence to be done once per user.
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.
"9/' Read the BillQuick Getting Started Guide for related procedures and details.

Reference Info

PRODUCT LICENSING & USER MANAGEMENT—LICENSES TAB

Navigation File menu, Licensing and User Management

The following are descriptions of fields on the Product Licensing and User Management
Console-Licenses screen:

Product:
Lists the various software products for which licenses can be assigned to users. The list
consists of BillQuick and its add-ons like Agent, Web Suite, etc.

License Key:

Encrypted sequence that uniquely identifies your company and authorized user count. The
BillQuick or any other product license key is based on your company name. If you have
purchased a license, you need to enter the licensed company name in the Company screen
prior to entering the license key here. License keys are stored in the database. If the
company name is changed after the database is licensed, the result will be an unlicensed
program.

Users:

The total number of licenses purchased for a BQE Software product. It displays after you
enter the license key. Additional licenses can be purchased at any time, which increases this
number.

Users = Assigned + Available

In Use:
The number of licensed users that are logged into a program simultaneously. Thus, it equals
the currently logged users for a program.

Assigned:

The number of unique login IDs and simultaneous users allowed in the program. It depends
on the number of licenses purchased for your software. BillQuick Users can be assigned in
the Employee and Vendor screens in BillQuick as well as from the Users tab of this screen.
Users for other products can be assigned from their respective programs as well as the
Users tab here.

Assigned = Users - Available

Available:

The number of licenses remaining or still available for a software product. The available
number of users can be assigned to the desired employees and vendors.

Available = Users - Assigned
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I'@'To obtain your license key, contact BQE Software at 888-245-5669, email
Sales@bge.com or fax (310) 784-8428.

PRODUCT LICENSING & USER MANAGEMENT— USERS TAB

Navigation File menu, Licensing and User Management

The following are descriptions of fields on the Product Licensing and User Management
Console-Users screen:

View By:

You can choose the desired view mode by employees, vendors or their groups. For example,
if you choose Employees Only, only employees will display in the grid and hence those can
be authorized to use any licensed program. Similarly, if you choose a group, then members
of that group will be available for assignment as authorized users of a program.

From-To:

Depending on what is selected in the View By field, employees, vendors or their groups can
be selected from these drop-down lists. You can select a single ID or a range of IDs in the
From-To fields.

Show Active Only:
Check this option if you want to display only active employees and vendors in the grid.
Unchecked, the inactive employees and vendors will also display but will be grayed out.

Grid
Field Chooser:
o

Click =1 to open the Field Chooser to hide or show columns in the grid. Check the field
names you want to show in the grid. You can also drag-and-drop fields between the Field
Chooser and the grid. Whether or not fields are hidden, values are recorded to them when
data is entered. By default, some of the fields are already checked and displayed in the grid.
Uncheck them if you want to hide them in the grid. The column names in the Field Chooser
are listed in the alphabetical order.

Employees/Vendors:

Displays a list of employees or vendors, depending on your View By mode and From-To
range. The desired employees or vendors can be assigned as authorized users of the listed
program. Only assigned users can log into a program.

Name:
Displays the name of the employee or vendor. It uses the Last Name-First Name format.

Security:
Displays the pre-define security profiles assigned to the employee/vendor. However, you
can change it here by selecting another profile from the drop-down list.
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BillQuick/Web Suite/Agent/Outlook Add-In:

This is the list of available programs—BillQuick and its add-ons. You can assign or un-assign
users for all these programs by checking the relevant boxes. You can also assign or un-
assign all the available users for a program using the Assign/ Un-Assign buttons.

Password:
You have the ability to change passwords of employees or vendors here by entering a new

one here. When you enter or change any password, BillQuick prompts you to verify it by re-
typing it in the Confirm Password dialog box.

How Do I

HOW DO I ACTIVATE BILLQUICK?

On installing BillQuick, you are prompted with the Product Activation screen. On startup,
you can select any of the following options:

e Activate Now—allows you to obtain an evaluation key for a 15-day trial.

e Activate Later—allows you to continue working with BillQuick during a 7-day
activation period. After this period, you must obtain an evaluation key or subscribe
to the full software.

e [ am Ready to Buy—option allows you to provide your details to BQE Software to
subscribe to the software. This is how BQE Software will contact you with your
license and registration keys.

e Already Purchased—option allows you to license and register your BillQuick software.

.
I‘Q-f'Check the BillQuick Getting Started Guide for procedures and details.

HOW DO I LICENSE AND REGISTER BILLQUICK?

BQE Software provides various options for licensing and registering your copy of BillQuick.
You can use the Product Activation, Company or Product Licensing and User Management
screen in BillQuick to do so. The BillQuick Supervisor usually licenses and registers the
BillQuick software.

I‘Q-f'Check the BillQuick Getting Started Guide for procedures and details.

HOW DO I ADD LICENSES TO BILLQUICK?

Please follow these steps to add additional licenses to your copy of BillQuick:

Start BillQuick and log in as a Supervisor.

Select View menu and open the Company screen.

Click on the License tab.

Replace the existing License Key with the new one (sent to you via email).
Click Save and then Close.

Install BillQuick on the new workstation or computer.

ounhwhe
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7. Open BillQuick and from the File menu, select Open Company, Standard Database
(or whichever database you are using).

8. Browse and select your company’s BillQuick database.

9. After your BillQuick database is open, select File menu, Registration.

10. Enter the Registration Key (sent via email) and click OK.

9Repeat steps 6 to 10 on other computers, if required. This depends on the number of
additional licenses you have purchased.

HOW DO I UPDATE LICENSE KEY?

BQE Software provides new license keys
¢ when you change your company name (spelling, punctuation, etc.)
when you purchase additional user licenses
when you upgrade to a new version of software (such as, from BillQuick 2016 to
BillQuick 2016)
To update your license key:
1. Open the Company screen from the View menu.

2. Click the Licenses tab.

3. Enter the new License Key received from BQE Software in the field provided or cut-
paste it from the License and Registration email.

4. Click Tools and select Validate License Key.
5. Next, click Save. It updates the Number of Licenses and Edition fields on this tab.

6. When you have finished, click Close.

.

"9/' If you type the License Key or Company Name incorrectly, a message displays. Enter the
information again. If the error persists, contact BillQuick Support at (310) 602-4030 or
Support@bge.com.

BILLQUICK LOGIN

Navigation File menu, Login

When security is turned on, the Supervisor and other BillQuick Users—employees and
vendors—are supposed to log into the program to access its functions and features.

The following are descriptions of fields on the BillQuick Login screen:
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The default User ID and Password is supervisor. You must enter your own ID and
password. When you enforce strong password policy in your company using the option in
Global Settings, users are required to reset their passwords every specific number of days.

If you are the only person using a particular computer to access BillQuick, mark the
Remember check box to make your User ID the default one. The Login screen also displays
the company name and path to its database.

Window Authentication:

BillQuick allows you to use the Windows Authentication option wherein you do not have to
specify a login ID or password when connecting to your database. Your access to the
BillQuick database is controlled by your Windows NT account or group, which is
authenticated when you log on to the Windows operating system on your system (client
machine). Hence, you can bypass a separate login for BillQuick program.

BillQuick Login Button Panel

Help:
Opens the BillQuick Help in the BillQuick Login section.

Cancel:
Cancels the changes and closes the screen.

OK:
Accepts the User ID and Password allowing you to log into BillQuick.

.
"9/' For details, check the BillQuick Getting Started Guide.

NAVIGATION

Menus

MENU OVERVIEW

BillQuick organizes its functions, features and reports into menus. Like all Windows
programs, BillQuick has a menu bar at the top from where you can access all the menus
and submenus.

File Menu—Contains commands that perform file-related tasks such as creating and opening
databases, login, and more.

Edit Menu—Contains the standard editing commands, such as cut-copy-paste, delete, and
more.

View Menu—Provides access to master information, dashboard, wizards, etc.

BillQuick | Power Up Your Business 72
(866) 945-1595 | www.bge.com | info@bge.com


http://www.bqe.com/
mailto:info@bqe.com
http://www.bqe.com/media/PDF/BQ/2016/BillQuick-Getting-Started-Guide-2016.pdf

(bqe BillQuick HELP MANUAL

Project Menu —Contains commands to create projects and access related project
management tools.

Time-Expense Menu —Provides access to time and expense entry screens.

Billing Menu—Contains commands related to billing and invoicing.

Reports Menu—Provides access to common reports and related reporting tools.
Settings Menu—Provides access to security features and administrative settings.
Utilities Menu—Provides access to various utilities and tools.

Integration Menu— Contains commands to sync or transfer data between BillQuick and your
accounting software.

Accounting Menu—Contains commands to access the accounts payable modules.

Add-Ons Menu—Lists and provides access to the BillQuick Add-Ons.

Window Menu—Lists all open windows in BillQuick, along with standard window commands.
Help Menu—Provides access to the BillQuick Help file and related support resources.
Reference Info

FILE MENU

The File menu contains commands that perform file-related tasks, such as creating new
databases, opening sample databases, licensing and registering software, converting data
from other software and so on. It contains the following commands:

¢ New Company—Opens the New Company submenu which allows you
to create a new BillQuick company database, whether Standard
(Microsoft Access), SQL Server Standard, SQL Server Express, MySQL
or Oracle database.

e Open Company—Opens the Open Company submenu, where you can
select an existing BillQuick database, whether Standard (Microsoft
Access), SQL Server Standard or SQL Server Express Database.

e Open Sample Company—Opens a submenu where you can select
industry-specific sample databases. The options include Sample
Company File/Architectural Company/Accounting Company/ Consulting
Company/Legal Company. Depending upon your selection, you can
have customized labels and lexicon available in BillQuick.

e Upsize to SQL Server—Opens the BillQuick SQL Database screen,
where you can create new SQL Server database.

e Login—Opens the BillQuick Login screen from where authorized users
can log in to BillQuick when security is turned on.

e Log Viewer—Opens the Log Viewer screen that records all actions and
functions performed in BillQuick to maintain an audit trail.
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Licensing and User Management — Opens the Product Licensing and
User Management Console that allows you to manage the licensing and

user authorization of BillQuick and all other add-ons.
Registration—Opens the Registration screen where you enter your
registration key. Your BillQuick database must be licensed and
registered for use beyond 15 days.

Printer Setup—Opens the Print dialog box, where you can set up your
printer and print options.

Exit—Ctrl+Q—Closes all open screens and BillQuick.

EDIT MENU

HELP MANUAL:
BillQuick Help

The Edit menu of BillQuick contains standard Windows text editing commands. These

commands are available for only text fields. It contains the following commands:

Undo—Ctrl+Z—Undoes the effect of the last action in the active screen.
Cut—Ctrl+X—Deletes the selected text or entry from the current field
and places it on the clipboard. The text can be inserted using the Paste
command into another text field in the active screen.
Copy—Ctrl+C—Copies the highlighted text or entry to the clipboard.
The text can be copied using the Paste command into another text field
in the active screen.

Paste—Ctrl+V—Inserts the cut or copied text from the clipboard into
the current text field in the active screen.

Paste Special— Inserts the text or entry from the clipboard into the
current text field in the active screen after allowing some modifications
to it.

Delete—Ctrl+D—Deletes the selected text or record from the active
screen.

Refresh—F5—Retrieves the latest data from the database and displays
it on the active screen.

Field Chooser—Displays the field chooser for the active screen. It
allows you to show/hide the desired fields in the grid.

Change Password—Opens the Change Password screen, allowing you
to change your login password.

Send to Excel—Allows you to export the currently selected data to
Microsoft Excel.

Find—Ctrl+F—Opens the Find screen that can be used to quickly search
for specific data or set of records.

Memo Toolbar—Displays the toolbar for the memo if it is not visible in
the memo box.

VIEW MENU

This menu contains commands to open various BillQuick screens. This menu contains the
following commands:
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e Company—Opens Company screen. The Company screen allows you to
create a profile of your business.

e Employees—Ctri+Shift+E—Opens the Employee screen. The Employee
screen allows you to create and maintain a profile of each employee.

e Clients—Ctrl+F8—O0pens the Client screen. The Client screen allows
you to create and maintain a profile of each client.

e Activity Codes—Ctrl+F5—O0pens the Activity Codes screen. The
Activity Codes screen allows you to create and maintain a standard list
of activities or tasks for your company.

e Expense Codes—Ctrl+F7—O0Opens the Expense Codes screen. The
Expense Codes screen allows you to create and maintain a standard list
of expenses for your company.

e Service Fee Schedule—Ctrl+F6—O0pens the Service Fee Schedule
screen. It allows you to assign multiple bill rates to one or many
employees based on the activity performed.

e Expense Fee Schedule—Ctrl+Shift+S—O0Opens the Expense Fee
Schedule screen. It is used to define special expense rates or markups
for billing.

e Vendors—Ctri+Shift+D—Opens the Vendor screen. The Vendor screen
allows you to create and maintain a profile of each vendor.

e Client Contact—Opens the Client Contact screen, allowing you to enter
information for the client contact.

¢ Manage Attachments—Opens the Manage Attachments screen. The
screen allows you to view all the linked files that have been attached to
BillQuick records.

e Workflow—Opens the Workflow screen. It allows you to track all the
submit-approve events in BillQuick.

e To Do List—Opens the To Do List screen. You can add and track your
to-do tasks here.

¢ Messages—Opens the BillQuick Messages screen that allows BillQuick
Users to send and receive messages within the network.

e Terms—Opens the Terms screen that allows you to set payment terms
for billing.

¢ Reminders—Ctrl+Shift+R—Opens the Reminders screen. You can view
all the reminders here, whether triggered by the system or set by you.

e Dashboard—Opens the Dashboard. The dashboard contains a series of
widgets or mini-programs that extract information from your company
database and present it as charts, lists and graphs.

¢ Navigator—Ctrl+Shift+N—The main navigator allows you to perform
most of the tasks required in BillQuick without having to locate
commands in menus.

e BillQuick Web Site—Opens the BillQuick User page. Your computer
must be connected to the Internet to use this option.

e Current BillQuick Users—Opens a message box displaying the
currently logged users of BillQuick.

e Wizards—Opens a submenu from where you can access wizards to set
up employees, clients, projects, activities, fee schedules, etc. You can
also access the BillQuick Startup Interview, Invoice Wizard, etc. from
here.
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PROJECT MENU

Project menu contains commands to create or edit projects, budgets, etc. This menu
contains the following:

¢ Management Navigator—The Business Management navigator allows
you to perform most of the project management-related tasks in
BillQuick without having to locate commands in menus.

e Project Center—Opens the Project Center which is a control center for
all project managers.

e Project Information—Ctrl+Shift+P—Opens the Project screen. The
Project screen allows you to create and maintain a profile of each
project.

e Allocation and Forecasting—Opens the Allocate screen allowing you
to allocate hours and units to employees.

e Budgets—Ctrl+Shift+G—Opens the Budget screen, which enables you
to set up budgets and track the expected revenue or cost of a project
against the actual.

e Estimates—Opens the Estimate screen that allows you to draft the
expected costs and incomes for a project.

¢ Project Control—Ctrl+Shift+J— Opens the Project Control screen. It
allows you to assign employees, activities and expenses to a project.

e Project Notes—Opens a submenu from where you can access Note
Categories and Project Notes screen.

e Assign Schedules and Budgets—Opens the Assign screen, allowing
you to assign service fee schedule, expense fee schedule, budget and
estimate to a project.

¢ Document Management—Opens the Document Management screen
that allows you to view the client files, folders and email.

TIME-EXPENSE MENU

This menu contains commands to access the time and expense entry screens in BillQuick.
The options include:

e Time Expense Navigator—The Time & Expense Navigator allows
you to perform most of the time and expense related tasks
required in BillQuick without having to locate commands or
screens in the main menu or toolbar.

e Enter Time— Opens the time entry submenu. The menu gives
you various options for entering time:

o Sheet View—Ctrl+T—Opens the Time Entry-Sheet View
screen. Time entries can be entered and reviewed from
this screen.

o Simple Time Card—Opens the Simple Time Card screen.
This allows you to enter time entries on a weekly basis.
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o Calendar View—Ctrl+W—Opens the Calendar View
screen. Time entries can be entered and reviewed from
this screen on a weekly basis.
o Timer—Ctrl+Shift+S—Opens the Timer. The Timer is a
stopwatch that is used to time activities as you multi-task.
o Open Unsaved Timers—Opens all the timers that have
unsaved time waiting to be logged to the database.
Enter Expense—Opens the expense entry submenu. The menu gives
you various options for entering expenses:

o Expense Log—Ctrl4+L—Opens the Expense Log screen
where expense entries can be entered and reviewed.
o Simple Expense Log—Opens the Simple Expense Log
screen. This allows you to log expenses on multiple
projects on a weekly basis.
Review Time and Expenses—Gives you an option to review time and
expense entries together in the Reviewer screen.
Personal Time Off—Opens the PTO submenu. This menu gives you
various options:

o Request PTO—Opens the Personal Time Off Request
screen that enables you to request personal time off.

o Review PTO—Opens the Personal Time Off Review screen
where PTO requests can be reviewed and approved.

BILLING MENU

This menu contains commands related to the billing procedures and invoices.

Billing Navigator— The main Billing navigator allows you to perform
common billing and invoice-related tasks in BillQuick without having to
locate them in the menus.

Create Invoices —Opens a submenu that gives you the following
options:

o Billing Review— Ctrl+Shift+K— Opens the Billing Review screen.
Billing decisions are made here.

o Manual Invoice— Ctrl+Shift+U— Opens the Manual Invoice
screen. It enables you to create a quick invoice for a project that
has no time or expense logged to it.

o Billing Schedule —Opens the Billing Schedule screen. You can
set up schedules for easy and regular billing of projects.

o Retainer Management— Opens the Retainer Management
screen. You can manage your retainer invoices and payments from
here.

o Memorized Invoices— Opens the Memorized Invoices screen.
Here you can view all active memorized invoices.
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Review Invoices— Opens a submenu that gives you the following
options:

o Invoice Review— Ctrl+Shift+I— Opens the Invoice Review
screen. All invoice records that exist in your BillQuick database can
be reviewed and finalized here.

o Statements —Opens the Statements screen. Various statements
can be printed from here or the Invoice Review screen.

Receive Payments— Opens a submenu that gives you the following
options:

o Payments— Ctrl+Shift+Y—Opens the Payment screen. It allows
direct input of payments as well as a review of previous payments.

o Credit Memo —Opens the Credit Memo screen wherein you can
create and print credit memos and payments.

o Process Credit Cards-Opens the Credit Card Processing screen.
This allows you to receive payments using credit cards.

o Download Credit Card Payments— Opens the Download
Payments screen. Here you can view all the payments that have
been made to your company via credit cards.

Collections Center-Opens the Collection Center screen which allows you
to track your A/R and manage all your collections from a single screen.

REPORTS MENU

The Reports menu contains commands that enable you to generate and print reports.
BillQuick provides a wide variety of standard reports that are designed to give you quick and
easy access to your company information. You can access the following features and options
from this menu:

Report Center - Opens the Report Center where you can access and
generate reports using various filters.

Memorized Reports—Displays a submenu that lists all your
memorized reports.

Favorite Reports —Displays a submenu that lists all the reports
marked as your favorite.

The menu also provides easy access to following report categories. The related reports are
categorized into groups for easy identification. When you select a report from the Reports
menu, the Report Filters screen displays.

Aging—Contains aging-related reports

Billing—Contains reports relating to billing, write-up/down, statements, etc.
Client—Contains reports related to clients

Company—Contains reports related to company and staff
Employee—Contains reports related to employees, time and expenses
Project—Contains reports related to projects, time and expenses
Payments—Contains reports related to payments and vendor bills
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e Analysis—Contains analysis reports related to billing, costs, WIP, etc.

e Activity—Contains activity and expense related reports

e Accounting—Contains reports related to accounting-accounts payable, general
ledger, and other financial reports.

Besides these, the Reports menu also provides access to:

e Custom Report List—Opens the Custom Report List screen which lists
all your customized report templates.

e Design/Edit Reports, Invoices—Opens Crystal Reports for BillQuick.
Crystal Reports enables you to design and customize reports.

SETTINGS MENU

The Settings menu contains commands that allow you to set up various preferences in
BillQuick. This menu contains the following options:

e Global Settings—Opens the Global Settings screen. These are
company-wide settings that will affect the behavior of every
machine running BillQuick.

e User Preferences—Opens the User Preferences screen. The
preferences selected here override those in the Global Settings
screen.

e Custom Labels—Opens the Custom Labels screen. BillQuick
gives you the ability to customize labels and captions to your
preference.

e Custom Labels Off—Resets all the custom field labels and
captions to the default value.

e Employee Control—Opens the Employee Control screen. You
can control what projects, activities or expenses an employee
can access throughput BillQuick.

e Security—Open a submenu with these options -

o Set Security opens the Security screen. Security can be
set per employee to restrict their access to features and
screens in BillQuick.

o Turn Security On/Off is a toggle option that turns the
security on or off in BillQuick.

e Currency Manager—Opens the Currency Manager screen that
enables you to manage multiple currencies in BillQuick for billing
purposes.

e Auto Complete—Opens the Auto Complete screen that allows
you to create shorthand codes and their corresponding longhand
explanations.

UTILITIES MENU

The Utilities menu provides access to many database utilities and other useful tools.

e Backup Database—enables you to create a backup of
your BillQuick database.
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e Restore Database—enables you to restore the previously
backed-up database.

e Archive and Restore Data— Opens the Archive and
Restore screen enabling you to archive or restore BillQuick
data.

e Import/Export—Opens the Import/Export screen from
where you can import and export data.

¢ QuickUpdate—Opens the QuickUpdate tool that enables
you to update rates in a batch mode.

e Change ID Codes —Opens a submenu from where you
can change IDs of clients, projects, employees, activities,
fee schedules, etc. using the Change screen.

e Add Industry Codes—Opens the Add Activity Codes
screen. BillQuick allows you to import some standard
activity codes into your database. Select your type of
business and BillQuick will then add the standard activity or
service items to your BillQuick database.

e Overtime Calculator—Opens the Overtime Calculator
screen that allows you to analyze your staff’s timesheets
and mark qualifying entries as overtime automatically with
appropriate overtime rates.

e Recalculate Account Summaries—Recalculates all the
account summaries. This tool should be run whenever
there is a major change in your database, such as after
integrating data with another program.

e Optimize—opens the Optimize Database Submenu. You
can attempt to repair all errors and optimize the BillQuick
database.

e Force Close DB Connection—Closes all open database
connections to remove unnecessary drain on it.

e Reassign Employee—Opens the Reassign Employee
screen allowing you to replace one employee by another.
This is a good project management practice.

INTEGRATION MENU

This menu provides data integration options with various financial and payroll accounting
software.

e QuickBooks—Opens a submenu. It contains various
options and settings for data synchronization with
QuickBooks program.

e Sage 50—O0Opens a submenu. It contains various
options and settings for data synchronization with Sage
50 (formerly Peachtree) program.

e MYOB—Opens a submenu. It contains various options
and settings for data synchronization with MYOB
program.

e Export Invoices to LEDES—Opens a submenu with
LEDES 1998 Format and LEDES 2K XML Format options.
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It opens the Export BillQuick Invoices to LEDES Wizard
from where you can export BillQuick invoices to the
LEDES format.

ACCOUNTING MENU

HELP MANUAL:
BillQuick Help

This menu provides various accounts payable options.

Accounting Navigator—Opens the Accounting navigator with
the most common accounting functions.

Chart of Accounts—Opens the Chart of Accounts screen, which
shows a complete list of accounts that have been created for
your company and their total balances.

Class—Opens the Class List screen that allows you to create
new classes for BillQuick items.

Purchase Order—Opens the Purchase Orders screen, which
allows you to keep a record of products ordered from vendors.
Receive Items—Opens an intermediate Open Purchase Orders
screen, from where you can access the Receive Items screen.
Receive Items and Create Bill-Opens the Receive Items
screen to allow you to create vendor bills.

Vendor Bills—Opens the Vendor Bills screen, which allows you
to create invoices for products and services that your company
purchases from vendors.

Enter Credits—Opens the Enter Credits screen that allows you
to enter credit information of vendors.

Pay Vendor Bills—Opens the Pay Bills screen that allows you to
pay vendor bills.

Make Deposits—Opens the Make Deposits screen that enables
you to make deposits into your bank accounts.

Transfer Funds—Opens the Transfer Funds screen that allows
you to transfer funds from one account to another.

Reconcile Accounts—Opens the Reconcile Accounts screen that
allows you to reconcile bank accounts and statements.

Write Checks—Opens the Write Checks screen that allows you
to write checks and make payments.

Print Checks—Opens the Print Checks screen that enables you
to view and print the checks written earlier.

Memorized Transactions—Opens a submenu that allows you
to access the Memorized Bills and Memorized Checks screens.
Use Registers—Opens the register for the selected balance
sheet account.

Other Registers—Allows you to open the register for the
selected account.

General Journal Entries—Opens the General Journal screen
that allows you to record journal entries for various accounts and
transactions.

Credit Card—Opens the Credit Card screen that allows you to
record various credit card transactions.
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ADD-ON MENU

This menu enlists the BillQuick Add-Ons (software products that enhance the use of
BillQuick). Clicking on any of the products takes you to the related information on the BQE
Software website.

¢ Agent- Opens the Agent product information on the BQE website
¢ Waeb Suite— Opens the Web Suite product information on the BQE website
e Outlook Add-in - Opens the Outlook Add-In product information on the BQE

website
e BillQuick Mobile— Opens the BillQuick Mobile product information on the BQE
website

¢ BillQuick HR— Opens the BillQuick HR product information on the BQE website

WINDOW MENU

The Window menu contains two sections. The top section lists the standard Windows
commands. The bottom section lists all open windows, if any, which are currently open in
BillQuick. The options change depending upon the Tabbed MDI settings in the User
Preferences screen.

e Cascade—Sets all open windows to the same size and stacks
them one on top of the other. Except the top window, only the title
bar of each window is visible. Because each title bar is visible, it is
easy to switch between windows by clicking on them.

e Close All Windows—Closes all open windows and dialog boxes
without exiting BillQuick.

e Tile Horizontally—Arranges all open windows in such a way that
they are stacked, one over the other, in a horizontal manner. The
title bar and full screen of the top window is visible, while the
screens of the other windows is partially visible.

e Tile Vertically—Arranges all open windows in such a way that
they are stacked, one over the other, in a vertical manner. The
title bar and full screen of the top window is visible, while other
screens are partially visible.

e Minimize All Windows—Minimizes all the open windows and
displays their tabs at the bottom of BillQuick.

The menu also displays a list of all open windows with the active window selected. You can
select any of the other open windows from this menu and make it active.

HELP MENU

The Help menu contains commands that provide help and other resources to BillQuick users.
It contains the following commands:

e Contents—Opens the BillQuick Help with the Contents tab
active.
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e Frequently Asked Questions—Opens the Support FAQs page
on the BQE website, where you will find answers to various
questions.

e Support—Opens the BillQuick Support page on the BQE website,
where you can access technical support and related resources.

e Support Downloads—Opens the BillQuick Support Downloads
page on the BQE website, where you can access program setups,
service packs, software updates, agreements, etc.

e Support Remote Assistance—Opens the BQE Remote Assist web page that
provides remote assistance to users having any problem with the software
program. It allows a BQE Support Professional to view your computer screen and
work on it over a secure connection. Before using this service, you have to agree
that during the session, the BQE Support Professional might record it. This results
in your communication being recorded and logged by BQE.

e Get Updates —Checks for and downloads the updates from the
BillQuick server, if available. You will need to use this option
when you have not opted for Automatic Updates in the User
Preferences screen.

e About BillQuick—Opens the BillQuick splash screen, where you
can view information about the BillQuick program.

TOOLBAR

The main toolbar allows you to access the most common and important BillQuick functions
and screens quickly. You can choose to show or hide the main toolbar from the right-click
menu or User Preferences-Options screen; Add/Remove Buttons on it according to your
needs (left-click option) or reset it to the default (left-click option). By default, the following
tools are available on the main toolbar:

open - O 48 3 = ©O € 8 & , = E | _
Open Data File—Opens a drop-down list from where you can select another BillQuick

database—Standard (Microsoft Access), SQL Server Standard or SQL Server Express
Database.

Find—Opens the BillQuick Find screen. This is a powerful tool that can be used to
quickly locate a specific set of records.

Employee—Opens the Employee screen. The screen allows you to create and
maintain a profile of each employee.

Client—Opens the Client screen. The screen allows you to create and maintain a
profile of each client.

Project—Opens the Project screen. The screen allows you to create and maintain a
profile of each project.

Time Entry—Opens the Time Entry-Sheet View screen where time entries are entered
and reviewed.
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Simple Time Card—Opens the Simple Time Card screen where time entries are
recorded on a weekly basis.

Timer—Opens the BillQuick Timer. The Timer is a stopwatch that is used to time
activities as you multi-task.

Expense Log—Opens the Expense Log screen. The screen is used to enter and review
expenses.

Simple Expense Log—Opens the Simple Expense Log screen where expense entries
are recorded on a weekly basis.

Billing Review—Opens the Billing Review screen. Billing decisions are made and
invoices are processed in this screen.

Manual Invoice—Opens the Manual Invoice screen. The screen enables you to create
invoices for projects that might or might not have time and expenses.

Invoice Review—Opens the Invoice Review screen where invoices can be reviewed
and distributed.

Payments—Opens the Payment screen. The screen allows you to record payment
information as well as review previously recorded payments.

Open Register—Opens the Use Register window that allows you to select an account
and view its transaction details in a register.

Dashboard—Opens the Dashboard. It enables you to view key metrics of your
business. Lists and graphs present key and summarized information about your
projects.

BillQuick Help—Opens the BillQuick Help allowing you to access detailed information
about BillQuick.

NAVIGATORS

Navigation View menu, Navigator

BillQuick navigators let you easily understand the workflow and quickly access important
features and modules of the program. These navigators have active action buttons, data
flows, charts, work flows and links, making it easier for first time as well as experienced

users to work with BillQuick. It includes one role-based navigator and five function-based
navigators. You can choose to make any one of them your default navigator.

9Depending on the screen resolution and size of your monitor, all panels on the navigator
might not display. BillQuick requires a 1024 x 768 or larger screen resolution.
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Role-Based Navigator

It displays as your home page and is customized according to your role in the company,
giving you easy access to the most often used functions. This role is specified by the
Supervisor in the Employee or Vendor screen depending on what your most frequent tasks.
There are four role-based navigators—Default, Time & Expense, Billing and
Principal/Management. Note that the role assigned does not affect access to other functions
(which is controlled by your security settings.) The role-based navigator is your home page
that offers the core functions you need—all at the same place. You can view submitted time,
expenses, invoices, budgets, estimates and purchase orders on the Workflow panel;
reminders and alerts on the Reminders panel; important messages and invoice notifications
on the Messages panel, besides access the commonly used screens and links.

9Whi|e the role of an employee or vendor determines the role-based navigator and
options available on it, the security profile or permissions assigned to them supersede it and
determine what functions and options are available to them. However, custom security
settings won't supersede the role.

Besides the role-based navigators, there are five main function-based navigators in
BillQuick. These navigators are fixed and more diverse than the role-based navigators. They
can be accessed from the Sidebar and main menu. Navigators refresh when you log out of
and log in to BillQuick. The main five navigators are:

Company Navigator

It allows you to access various company-related screens such as Employee, Project, Client,
Activity, Payments, and so on. You can also access other modules from its Utilities panel,
such as Security, Backup, Tutorial, and more. The Charts panel displays various graphs and
charts for the desired year. The Workflow panel lists the submitted time and expense
entries awaiting approval. The Recent Reports panel lists the last five reports generated by
the logged-in user and also provides access to more reports in the Report Center. The
Spotlight panel contains links to the BillQuick blog, knowledge base, etc. on the BQE
website. You can access any of these functions based on your security profile.

Business Management

This navigator allows you to access various client and project management screens such as
Client, Estimate, Project, Budget, Service Fee Schedule, Employee Control, Reports, and
more. You can also access other modules from the Tools panel, such as Document
Management, Find, Custom Labels, and more. The Charts panel displays various graphs and
charts for the desired year. The Links panel provides links to other managerial functions
such as Currency Manager, Global Settings, Reminders, and more. Reports panel lists the
latest reports generated by the logged-in user. You can access any of these functions based
on your security profile.

Time & Expense Navigator

It allows you to access various time and expense tracking functions required by a
timekeeper such as Sheet View, Timer and Expense Log. You can also access other useful
modules such as Employee, Activity, Invoice Review, Reports, and more. The Charts panel
displays various graphs and charts for the specified year. The Submit/Approve panel
provides links for the submission and approval of time and expense entries in BillQuick. The
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Reports panel lists the latest time and expense related reports generated by the logged-in
user. You can access any of these functions based on your security profile.

Billing

This navigator allows you to access various billing related functions such as Budget, Billing
Review, Invoice Review, Payments, Invoice Wizard, and more. You can also access other
relevant modules such as Time and Expense, Retainers, and more. The Reports panel lists
the latest billing reports generated by the logged-in user. The Charts panel displays various
graphs and charts for the desired year. The Links panel provides links to other modules of
BillQuick such as Service Fee Schedule, Activity, Currency Manager, and more. You can
access any of these functions based on your security profile.

Accounting

This navigator allows you to access the most common accounts payable functions, such as
Chart of Accounts, Vendor Bills, Write Checks, Register, and more. You can also access
some of the accounts receivable modules from here including Billing Review, Payments, etc.
There is a panel displaying graphs and charts for the desired year. The Reports panel lists
the latest accounting reports generated by the logged-in user. You can access any of these
functions based on your security profile. In addition, these functions are available only in
the BillQuick Plus editions.

SIDEBAR

On the left side of the BillQuick desktop, you can conveniently access the major functions
and screens from the Sidebar. This Sidebar is divided into four panels, grouping the
common functions together under each. These include:

Main

This panel allows you to access the main workflow navigators and master information
screens in BillQuick. You can open the Company, Management, Time & Expense, Billing and
Accounting navigators; Client and Project screens; and Dashboard by clicking on the
relevant option.

Time & Expense

This panel allows you to access time and expense related functions and screens in BillQuick.
You can open the Time & Expense (Home) navigator; Time Entry (Sheet View), Calendar
View, Timer and Expense Log screens by clicking on the relevant option.

Billing

This panel allows you to access billing related functions and screens in BillQuick. You can
open the Billing (Home) navigator; Billing Review, Manual Invoice, Invoice Review and
Payment screens by clicking on the relevant option.

Wizards

This panel allows you to access various master information, fee schedule and billing related
wizards. You can open the BillQuick Interview; Employee, Client, Project, Activity and
Expense wizards; Service Fee Schedule, Expense Fee Schedule, Phased Invoice and Invoice
wizards by clicking on the relevant option.

You can re-arrange the Sidebar items up or down by dragging-and-dropping them. You can
also display fewer items (or buttons) on it using the appropriate option.
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GENERAL FEATURES

Grids

GRIDS OVERVIEW

A grid is an arrangement of columns and rows that look similar to a table or spreadsheet.
BillQuick uses grids in all screens for drop-down lists, time and expense sheets, schedules,
master information lists, etc. Each row represents a unique data record while columns are
individual data fields. BillQuick grids have many features in common that allow you to
customize their appearance and navigate through BillQuick more efficiently. BillQuick
supports dynamic sorting and column re-sequencing for any grid. Sort and column order are
remembered the next time you work with the modules. You can also choose to show or hide
the desired columns in the grids.

You can customize the grids in many ways:

e Hiding/Showing Columns

e Sorting Grids

e Sorting Drop-downs

e Selecting Multiple Rows

e Re-arranging Columns
How Do I

HOW DO I USE GRIDS?

BillQuick grids have many features in common that allow you to customize their appearance
and navigate through BillQuick more efficiently.

Sort:

Sorting the records is as simple as clicking the column header. Click the column header to
reverse the existing sort order. They will be listed in ascending and descending order. To
sort by multiple columns, click the first column header (once for ascending order, twice for
descending order), then press Shift+click (point to the next column to sort).

Expand Entries:
Place the pointer on a record and double-click it. This expands the grid entries.

Re-arrange Columns:
You can change the sequence or position of columns in the grid by dragging the column
headers to the desired location.

Change Grid Size:
You can re-size the grids by placing the pointer on the edge of the screen. After your mouse
pointer becomes a split arrow, re-size the screen. The screen will open in the same position
and size next time.
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Change Row and Column Size:

Place the pointer on row and column dividers and drag them to the desired size. In many
grids, columns can be resized by dragging the right edge of the column header. Screen
grids also include the Best Fit and Auto Fit (AFC) feature for resizing columns. By default,
the latter option is selected for all grids.

Send to Excel:
Allows you to export the grid information to Microsoft Excel program. This option can be
accessed from the shortcut menu, screen toolbar or main Edit menu.

Hide/Show Columns:
Most of the screens allow you to hide/show the desired columns in the grid to customize it
_

to your style and also speed up data entry. You can do so from the =1 Field Chooser
available from the Edit menu as well as at the top left of the grid. For example, if you do not
charge taxes on expenses, you can hide the tax columns in the Expense Codes and expense
entry screens.

Filters:

S
You can use Funnel Filters () and Filter By Selection features on the grid to view selective
data. See Filters for more.

HOW DO I HIDE/SHOW COLUMNS?

At times, you might have too many columns displayed in a grid and want to simplify it by
hiding unused columns. For instance, Sheet View or Expense Log screens. On the other
hand, you might want to see more information than what displays by default on the
screens. For example, while doing percent complete billing in Billing Review screen, you
might want to show extra columns in the grid, such as % Complete, Contract Type and so
on.

To hide or show columns in a grid:

1. Open the desired BillQuick screen; such as, Expense Codes.

ol
2. Click Izl at the top left of the grid to open the field chooser window. Alternatively,
select Field Chooser from the Edit menu.
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3. Check the fields or column names you want to show in the grid. For example, you
might want to show the Tax column in the grid if you apply taxes on expense items.

4. Uncheck the fields or column names to hide those in the grid. You can also drag-

and-drop fields from the field chooser into the grid.

HOW DO I SORT GRIDS?

You can sort the grids in the order you prefer. You can sort the order of grid columns by

doing the following:

1. Open the desired BillQuick screen, such as, Time Entry-Sheet View.

2. Select the column on the grid that you want to sort.

3. Click on the column heading, say Date, once for ascending order and twice for
descending order. Clicking on the column header reverses the order of entries.

4. To sort multiple columns, click the first column heading, and then point to the next
column to sort, say Project ID. Press Shift+click. While pressing the Shift key, click
on the second column heading.

5. If you want BillQuick to always remember this sort order, click on the More tab. Then

check Remember Grid Sort Order option.

Similarly, you can sort grids in the Expense Log or other BillQuick screens.
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HOW DO I SORT DROP-DOWNS?

You can change the sort order of drop-down lists by doing the following:
1. Open the Time Entry-Sheet View screen.
2. Select any drop-down list on the grid, say Project ID.

3. Click on the column heading in the drop-down list, once for ascending order and
twice for descending order.

4. In some screens, you can also sort the drop-down lists by right clicking and using
the Sort By ID and Sort By Name options.

Whatever the sort order, BillQuick will remember it in future.

HOW DO I SELECT MULTIPLE ITEMS?

At times, you need to select multiple rows or records in a grid to perform some action on
them. For example, you might want to select rows to make batch changes to them or
submit them. You can select multiple rows or records using a combination of mouse click
and Shift or Ctrl keys. Else, use the Select button drop-down options available in BillQuick
screens.

e Use Ctrl+click to select individual items in a list.

e Use Ctrl+A to select all items in a list.

e Use Shift+click to select a range of items

e Use the Select button options to select or unselect all rows.

HOW DO I REARRANGE COLUMNS?

You can re-arrange columns in a number of ways to suit your preference:

e You can move the columns by dragging and dropping with the mouse at the desired
location.

¢ When too many columns are visible in a grid or too many records display, you can
use the vertical and horizontal grid splitters (as in Sheet View, Project, etc.). Drag
the grid splitters to split the grid at the desired place. Vertical splitters lock columns
while the horizontal splitters lock rows. These are available only with the vertical
and horizontal scroll bars.

e Columns can fit to the screen in two ways. Place the pointer on row and column
dividers and drag them to the desired size. You can also use the Layout button
options:

o Auto Fit—fits the columns to the screen
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o Best Fit—adjusts the columns to best fit the content

Filters

FILTERS OVERVIEW

Filters limit the number of records displayed in the grids and drop-down lists. They are data
management tools provided to lessen the task of managing a large BillQuick database. This
is helpful because it reduces the time taken to find, view or select data in any BillQuick
screen. There is no need to waste time in scrolling and scanning hundreds of items when
you want to view selective information.

For example, if you would like to view only the employees whose IDs range from A through
M, you must select that range in the relevant filter fields. Filters help in selective data
viewing not only in the grids and drop-down lists, but also on reports. See How Do I Apply
Filters for more.

Besides the regular filters available on the Filters screen, BillQuick also provides two
additional filter options on various grids.

Filter by Selection

A special 'Filter by Selection' option is available on many grids such as Activity Codes,
Expense Codes, etc. It allows you to filter the grid records by the contents of a cell. After
selecting a cell on the grid, you must right-click and select 'Filter by Selection' option from
the menu. The list filters instantly based on that item.

-
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Many BillQuick screens offer funnel filters () for selective viewing of data in the grids. You
can find them in screens like Reviewer, Project Control, Sheet View, Expense Log, etc.
Funnel filters allow you to be more specific as to what discrete items to display in the grid—
All, Custom, Blanks, Non-Blanks, etc. Data selectively displays in the grid depending on

your choice.
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If you select All, all records display in the grids. If you select Blanks Only, those records
display for which no value exists for the selected cell. Similarly, if you select Non-Blanks
Only, those records display for which any value exists for the selected cell. If you select

Custom, a new screen opens on which you can choose advanced options. You can set more
than one filter, add filter conditions or remove them.

In some screens like Sheet View, Billing Review, Reviewer, etc., the columns in the grid can

i
be filtered using the Excel style funnel filters (). You can apply pre-defined Text and
Number Filters on the columns or set your own Custom Filter.
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How Do 1

HOW DO I FILTER DATA BY GROUPS?

To filter records based on groups:
1. On any BillQuick screen, say Employee, click Tools and select Filters.
2. Click on the Employee Group filter and select ‘Administrative’ from the grid.
3. Check the filter option and then click Apply to apply that filter to the list.
4. Next, click OK.
5. The employee grid list is shorter now. To verify that the list contains only the desired
group members (Administrative), click on the employees in the list and check their

Department on the General tab.

5. When you have finished, click Close.

Clone

CLONE OVERVIEW

Setting up profiles for employees, vendors, clients, projects, and so on can be tedious and
time-consuming, especially when manually setting up information from another system.
Many records contain the same data. The BillQuick Clone feature allows you to duplicate a
record to a new one. After cloning records, you can add or modify the unique data. Cloning
does not change the original information or ID. Because BillQuick copies all fields from the
source record to the new record, using a clone template reduces editing and setup time.

You should examine your existing data for commonalities and then create a ‘clone template’
for each type. A clone template contains general or common data that you want to include
in all the new records. For example, if you employ many sub-contractors for network
installation and administration projects, it saves time to create a clone template for this
type of a vendor. Similarly, drafters in an architectural firm typically have similar
information in their records, such as bill rates, standard hours and so on. Again, you can
create a clone template for drafters and then use it to set up new profiles quickly. In short,
you can create a Staff Employee Template, Manager Employee Template, Standard House
Project Template, and so on. Be sure to give a special ID to each clone template.

You can use the cloning feature for many items in BillQuick, such as employee, project,
client, purchase order, and more. The following are descriptions of generic fields on the
Clone screen:

Clone From:
Select the ID of the item that is to be cloned from the drop-down list. For example, if you
want to clone the employee profile of Chris James, then select his ID (CJ) from the list.
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Clone To:

Enter the ID of the new record to be created. For example, To create a clone of CJ for a new
employee, Howard Roark, enter the new ID, HR here.

Clone Button Panel

Help:
Opens the BillQuick Help in the Clone section.

Cancel:
Cancels any action and closes the Clone screen.

Save:
Saves the cloned record and closes the screen.

Find Information

FIND OVERVIEW

Navigation Edit menu, Find

At times, you need to find records or data that contain important information, say, from a
conversation recorded within a time entry memo. You might remember typing it into
BillQuick Timer's memo as you talked to a client, but you cannot remember the exact date
or which client it was. All you remember is a reference to 'extension'. In BillQuick, searching
for such information is easy and fast.

The Find screen is a powerful tool that can be used to quickly locate a specific set of records
in any data table using simple or advanced criteria. You can match part of a field, whole
field, or only start of a field. In addition, wildcards can be employed to search for patterns.
Up to five keywords can be used in a search; each keyword narrowing or expanding the
search via the AND/OR option.

BillQuick provides you with two types of search options—the global find and the quick find.
Global Find uses the main Find screen to search for data. Quick Search Item uses the search
box in various screens to quickly find records or fields in the grid.

Reference Info

FIND

Navigation Edit menu, Find
The following are the descriptions for the fields on the Find screen:

Data Tables:

A data table in BillQuick must be chosen to locate specific records. You can choose from
various tables—Activity, Budget, Estimate, Client, Expense Log, Payment, Transaction,
Vendor Bills, etc. When you open Find from a BillQuick screen, it defaults to that specific

BillQuick | Power Up Your Business 94
(866) 945-1595 | www.bge.com | info@bge.com


http://www.bqe.com/
mailto:info@bqe.com

@ BillQuick e oL

table. Else, you need to highlight the name of the table that is to be searched for data. After
a table is chosen, the Find criteria must be entered.

Find Criteria

Keyword:

For a successful search, specify as many criteria as possible. After all the criteria for the
search have been entered, the Find button will initiate the search. Type the Keyword for the
item that you are trying to search. It is a character string used to find the desired records.
Enter all or part of the value. Wildcards (not case-sensitive) can also be used. A keyword
can be anything that is unique to one or a series of records. Up to 5 keywords can be
entered with different matching parameters, if desired.

For example, if you need to find an invoice but know only the Project Manager and Project
ID of that invoice. If you search using only the Project Manager criterion, BillQuick will
display all invoice records matching that project manager. This could be matched by
thousands of records or none at all. But if you select both the Project Manager and Project
ID, your search will be narrowed and most likely be more successful.

Keywords can employ wildcards to search for patterns. A percent sign (%) represents one
or more alphanumeric characters that appear in a position within a keyword. In contrast, a
hyphen (-) replaces only one character in a keyword. For example:

Returns sung, suns, sunset, sunrise,

% Sun% sunny, sundial
S%n Returns sin, son, sun, soon, scan, skin,
stun
Sun- Returns sung, suns
) S-n Returns sin, son

ﬂLetters used for searching are not case-sensitive.

Match:
e Any Part of Field results in the most general search. The keyword has to match any
part of a field in the selected table.
e Whole Field—the keyword has to match exactly and entirely a field in the selected
table.
o Start of Field—the keyword has to match only the start or beginning letter of the
field in the selected table.

AND/OR:

AND and OR are used to further refine the search. The AND option narrows the search to
inclusive criteria. Use the AND command when you are sure about more than one field in
the search. For example, if you know both the Employee ID and Project ID for your query,
use AND to display records that match both the Employee ID and Project ID. Enter the
Employee ID in one of these fields and the Project ID in a lower field. Select the AND radio
button. Only records that match both search criteria will be displayed.
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The OR option expands the search to exclusive criteria, resulting in a broader search. If you
want to display records that satisfy either Find criteria, you can enter both Employee ID and
Project ID, and select the OR radio button. The records displayed will be mutually exclusive,
meaning that BillQuick will present all records that contain the Employee ID as well as the
Project ID.

All Fields:

Selecting a specific field within the screen (table) to search for the keyword can narrow the
search further. After the table has been selected, you can browse this drop-down list for a
specific field to search. To broaden the search, select the All Fields radio button and
BillQuick will search each field in the selected table. All Fields is the default option.

Find Button Panel

Help:
Opens the BillQuick Help in the Find section.

Print:

Displays a preview of the search results according to the Find Results grid. Preview displays
the full screen representation of the report and allows you to print or preview the report.
The preview window provides you with various options: export or email report, page setup,
printer selection, navigation, modify fonts and items, zoom or sort data, find data,
memorize report, etc.

Layout:
Auto Fit:
BillQuick automatically adjusts the grid list so all columns fit in the grid window. Else,
the grid list columns display at default widths. Regardless of the settings, you can
adjust column width manually. By default, this option is on for grids.
Best Fit:
BillQuick automatically adjusts the grid list so that the columns fit the contents.

Load:

Loads the screen related to the search after displaying the Find Results. The search results
or record will be displayed from its screen of origin (say Employee ID results in the
Employee screen).

Clear:
Clears all the data entered for initiating the search.

New:
Click this to start a new search. It takes you to the initial Find screen. If your query is
unsuccessful, you can try to search again using different criteria.

Find:
Searches for the relevant data and displays the Find Results screen.

Close:
Closes the Find screen.
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aTo export records or results in the grid to Excel, click the 'Send these results to Excel'
link on the Find Results screen.

How Do 1

HOW DO I SEARCH ITEMS?

On the master information screens, the Search Item option instantly searches all the
records in the list as you type in the text box. BillQuick automatically suggests the nearest
matches in a drop-down list and narrows it as you keep on typing. If you remember just a
part of the Client ID or name, just:

-
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1. Enter the text you remember in the Search Item box. It displays a drop-down list of
possible matches.
2. You can select the record you are looking for from the drop-down list. Else, click

to find your match in the grid list.

dh
3. Click again or press Enter to find the next match.

BillQuick | Power Up Your Business 97
(866) 945-1595 | www.bge.com | info@bge.com


http://www.bqe.com/
mailto:info@bqe.com

(bqe BillQuick HELP MANUAL

HOW DO I GLOBALLY FIND INFORMATION?

To find information:

1. Open the Find screen from the Edit menu or by pressing Ctrl+F. Some screens also
contain a Find link to open this screen.

2. Select the desired type of information from the Data Tables list. If you have an active
window, that screen is pre-selected.

3. Enter your Find Criteria. Type a Keyword using '%' and '-' wildcards as needed.
Specify the search for a match in Any Part of Field, Whole Field or Start of Field.

4. Apply AND/OR search options, if needed.

5. Click Find. Immediately, BillQuick displays a list of records that contain the
keywords.

6. Click on any record to drill down to the details.
Groups

GROUPS OVERVIEW

Groups are a valuable tool. Companies can create groups to make it easier and faster to set
up and maintain master information, budgets, fee schedules, etc. Groups also act as filters
to shorten grid lists and reduce management effort. You can group employees, vendors,
activity codes, expenses codes, etc. in BillQuick based on shared or common attributes. You
can create groups to match situations, whether it is a refined group of clients or projects to
bill, groups for payroll items, groups for ledger accounts or groups for precision reports.

The great benefit is that you can also filter reports by these groups and expand the value of
reports. You can create groups for departments, type of project, type of client, region,
territory and skill set - virtually anything you want and then view reports accordingly.

Some of the common groupings include:

Projects: industry, commercial, not-for-profit, government, etc.
Employees: hired date, department, title, annual reviews, skills, etc.
Vendors: skills, location, ability to travel, etc.
Clients:
Architects/Engineers — commercial, residential and government
Accounting Firms — 1040 Tax, 1120 Tax, write-up, consulting, litigation support
Law Firms - contracts, bankruptcy, divorces, real estate
Computer Consulting — networks, remote maintenance services, solutions
e Activity Codes: tax services, rates, administrative, marketing, etc.
e Expense Codes: overheads, tax, costs, reimbursable, administrative, etc.

BillQuick group are dynamic; when you add or remove items from a group, they dynamically
update in the schedules, filters and other places to which they are applied. For example,
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when you add a new activity or remove an expense code from a group assigned to a fee
schedule, BillQuick updates the schedule accordingly. However, if you want to delete a
group that is included in any fee schedule, budget, etc., it is better to make it inactive.
Batch Change

CHANGE OVERVIEW

In certain situations, you might have to make some changes to the existing data. If the
data involved is huge, it can be tedious and time-consuming to make changes to each
record or entry. For example, an item tax change can affect dozens of expense codes.
Similarly, you might have to change the manager or payment terms for multiple projects in
bulk. Rather than select each item and make a change, BillQuick provides you with a batch
change feature that can update multiple items and records at a time.

The Change screen allows you to modify multiple records at once. It changes the contents
of a field from A to B for the selected records. If you need to change some fields from A to B
and others from C to D, perform the change function twice. The new data or values will be
applied to the selected rows only. The checked items will be the ones that will be altered in
the main screen.

You can make batch changes to all master records and other data in BillQuick.

How Do I

HOW DO I CHANGE ITEMS?

To change one or multiple fields in one or multiple BillQuick master records, follow the steps
mentioned below.

1. Open any of the master information screen, say Activity Codes from the View menu,
toolbar or navigator.

2. If the activity codes you want to update are all part of a group, select the Filter tab
and choose the Group filter to shorten the list. If not, continue to the next step.

3. Open any of the master information screen, say Activity Codes from the View menu,
toolbar or navigator.

4. On the Activity tab, scroll through the list and select the activity codes you want to
batch change.

5. Click Tools and select Change from the menu to open the Change screen.

6. Enter the new data for each field you want to update. BillQuick automatically marks
the adjoining check box.

e
A\ Review your work. If you incorrectly modify something, you must manually reset
or change each record.

7. Click Apply. BillQuick applies the changes to the selected activity records.

However, what do you do if the new data varies for different records? For instance, you
created 100 activities, of which 65 are billable while the rest are non-billable. Most of them
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have a fixed markup of 5%. Some have to be taxed once while others need to be taxed
twice. In this scenario, you would make multiple passes through the records using the
Change screen.

Memos

MEMO OVERVIEW

You can use memos to record important qualitative or quantitative information in BillQuick.
For example, you can enter a descriptive memo for an activity, expense, time entry,
invoice, vendor bills, and more. If your company or client prefers, you can add memos to
invoices as well as notes that explain the scope of work and change orders. You can add
memos to provide detailed information for internal (staff, managers, etc.) or external
(clients, vendors, etc.) use.

BillQuick allows you to customize the font style and size for all the memos at the global
level from the Global Settings screen. A memo comes with a floating toolbar with the
standard options like cut-copy-paste, font style, alignment, spell-check, etc. BillQuick allows
you to dock this floating toolbar, if desired. You can type unlimited length text in a memo
box or use Auto Complete shorthand codes to insert pre-defined standard text. You can add
a single memo to a record or item except invoices, where you can add two memos to each
invoice.

Most of the screens contain a collapsible memo box that can be opened by clicking or

pressing Ctrl+M. The memo box can be collapsed again by clicking EJ. You can choose to
show the memos on invoices and notes.

Reference Info

MEMO

A memo consists of a text box and formatting toolbar. This toolbar is floating but can be
docked if desired. The following are descriptions of fields on the memo toolbar:

Spell Check:
The Spell Check globally checks the spelling of the description and memo fields in the
screen. It identifies unrecognized and mis-spelled words and provides suggestions.

v X & v o8] U # = = = = | Anal >0 [~ %

Cut:
Removes the text selection from the memo and places it on the clipboard.

Copy:
Copies the text selection to the clipboard.

Paste:
Inserts the contents of the clipboard at the insertion point and then replaces any selection.
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Undo:
Reverses the last command or deletes the last entry.

Redo:
Reverses the Undo command.

Bold:
Makes the selected text and numbers bold. If the selection is already bold, clicking this
button removes the bold formatting.

Italic:
Displays the selected text and numbers in jtalics. If the selection is already italicized,
clicking this button removes the italic formatting.

Underline:
Underlines the selected text and numbers. If the selection is already underlined, clicking this
button removes the underline.

Strikeout:
Draws a Hnre through the selected text. If the selection already contains a strikethrough,
clicking this button removes the formatting.

Alignment:
Aligns or justifies the selected text to the left, center or right side, depending on the button
chosen-Left Align/Center Align/Right Align.

Bullet:
Inserts bullets in the text box. It is used for creating lists, points, etc. BillQuick can print
these bulleted lists on the invoices.

Font:

The font style applied to the selected text, the default being Arial. The memo applies the
font formatting to the current selection or entire word that contains the insertion point. To
apply font style to a portion of a single word, select that portion first.

ﬂBiIIQuick uses Century Gothic 8 pt on the invoices and reports. If you want your memos to
match the reports, you should change the memo font in the Global Settings screen.

Size:
Changes the size of the selected text and numbers, the default being 10. Select the desired
font size from the drop-down.

Date Time:
Inserts a date-time stamp on memo. This enables you to know when the memo was
entered.

Add New Auto Complete:

When you click '/, it allows you to add a new auto complete entry for the selected memo
text on the fly. It opens the Add New Auto Complete Entry screen.
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Memo Button Panel
In case of a Memo Pad (Billing Review and Invoice Review), the screen displays the
following buttons.

Clear:
Clears the memo text.

Save:
Saves the memo.

Close:
Closes the Memo Pad.

How Do 1

HOW DO I CREATE MEMOS?

Most screens in BillQuick contain built-in memos. All memos accept unlimited length of text.
Security permissions restrict your ability to add and edit memos.

e You can easily jump into and out of a memo with a mouse-click or by using shortcut
keys. For example, Simple Time Card and Expense Log have collapsible memo

boxes. Click to expand (and = to collapse) the memo box or press Ctrl+M to
jump in and jump out of it.

e To open a memo in some BillQuick screens, click Tools on the button panel and
select Memo.

e You can click on the Memo label to change a fixed memo box into a floating one
that can be easily resized.

e You can apply the desired formatting to the text using the floating or fixed memo
toolbar. You can dock the floating toolbar with the memo box, if desired.
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e You can enter Auto Complete shorthand codes into the memo. Besides that, you
can highlight the memo text and make an auto complete entry out of it by clicking

* on its toolbar.

e Click [Z]to insert a date-time stamp on your memo.

e Invoices can have one or two memos. On the Billing Review and Invoice Review
screens, you can enter two memos.
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Auto Complete

AUTO COMPLETE OVERVIEW

Navigation Settings menu, Auto Complete

Auto Complete is a feature that allows you to record longhand standard text and link it to a
shorthand code. Shorthand codes are abbreviations consisting of letters and numbers. When
you enter a shorthand code in a memo field (for example, Notes, Sheet View, Expense Log,
BillQuick Messages and Email), it instantly inserts the corresponding longhand text, phrases,
sentences, paragraphs or pages of text. It is a critical timesaving feature in BillQuick and
can be turned on/off from the User Preferences-Options screen.

You can create auto-complete shorthand codes in the Auto Complete screen or directly in
the memo box. BillQuick enables you to save any text-a phrase, sentence, paragraph or an
entire memo-as a shorthand code.

Auto Complete feature can be used with other BillQuick features. For example, using Auto
Complete and the Billing Review Change feature, you can quickly create a memo with
common Auto Complete codes, then batch copy the memo to hundreds of invoices. You can
edit memos using enhanced shortcut keystrokes for font attributes, cut and paste, undo,
alignment and more.

&Shorthand codes are case sensitive. For example, 'wu' code for 'write up services' is not
the same as 'Wu' or 'WU'. In addition, shorthand codes cannot contain punctuation or
spaces.

Reference Info

AUTO COMPLETE

Navigation Settings menu, Auto Complete

The following fields display on the Auto Complete screen:

Shortcut:

Enter the shorthand text or characters for which you want to create an Auto Complete

entry. This is the text you will be using in the memos, and so on.

Phrase:
Enter the longhand description for the shorthand code that you created in the Shortcut field.

Share this Shortcut:
If checked, this Auto Complete entry can be used by all users of BillQuick.

Both the shorthand and longhand text or phrase can be viewed in the grid.
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Auto Complete Button Panel

Help:
Opens the BillQuick Help in the Auto Complete section.

Cancel:
This button is visible only in the new entry mode. Cancels a new Auto Complete entry.

Layout:
Auto Fit:
BillQuick automatically adjusts the grid list so all columns fit in the grid window. Else,
the grid list columns display at default widths. Regardless of the settings, you can
adjust column width manually. By default, this option is on for grids.
Best Fit:
BillQuick automatically adjusts the grid list so that the columns fit the contents.

Send to Excel:
Exports the grid data to Excel by creating an Excel file (.xls). You need to specify the
location of the Excel file in the Send to Excel dialog box.

Spell Check:
Globally checks the spelling mistakes in the grid and text fields. It identifies unrecognized
words and provides suggestions.

Delete:
Deletes the selected entry.

New:
Click to enter a new Auto Complete entry. The pointer is placed in the Replace field so that
you can create a new shorthand-longhand entry.

Save:
Saves the shorthand and longhand entry and then displays it in the grid.

Close:
Closes the Auto Complete screen.

How Do I

HOW DO I CREATE AUTO COMPLETE ENTRIES?

To create Auto Complete shorthand codes:
1. Open the Auto Complete screen from the Settings menu.
2. Click New to enter a new shorthand code.

3. Type the shorthand text in the Replace field and the longhand explanation in the
With field.
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4. Check Is Shared option to make the shorthand codes available for all BillQuick users.

5. If desired, you can add a reminder in your longhand text by including [ ] (or other
unique characters like ~, > or ) as placeholder information, indicating a
timekeeper, billing manager or project manager needs to insert information specific
to the situation.

9If desired, you can add placeholders in longhand text of shorthand codes. Utilizing curly
{} or square [ ] brackets for easy identification, placeholders prompt you to add or edit
information for the situation—date, client name, contact name, issue and so on. If you
neglect to replace placeholders, a reviewer or manager can see the omission and ask for
correction. Standard text also makes it easier for managers to review memos because they
follow a standard, consistent format. Thus, when memos carry to detailed invoices, they
present a consistent, professional image.

6. Click Spell to perform a spell-check of the new Auto Complete text.

7. When you have finished, click Save and then Close.

9You can highlight the memo text and make an auto complete entry out of it by clicking
““ on its toolbar.

Custom Labels

CUSTOM LABELS OVERVIEW

Navigation Settings menu, Custom Labels

You can customize BillQuick to your preferred terminology. For various BillQuick screens,
you can change the screen title or caption, field labels, masks and user interface. Changes
immediately ripple to menus, screens, reports, invoices and even the program tool tips.

When running the BillQuick Start-Up Interview, you can select a Business Type. When you
choose one, BillQuick changes the main terms to ones common to the selected industry. You
can customize them further using the Custom Labels screen. Here, you can change the
BillQuick terms to any other common industry terms such as:

BillQuick Terms Common Industry Terms

Activity Code Task Code, Service Code, Work Code
Expense Code Expenditure, Charge Item
Project Job, Engagement, Matter, Work Order
Employee Timekeeper, Staff, Associate
Vendor Consultant, Subcontractor, Contractor
Client Customer
Time Entry Hours, Time Card, Time Sheet
Expense Log Expense Report, Expense, Charge Item
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Navigating the Custom Labels list is straightforward. It consists of a tree-structured list that
lists all the BillQuick screens and fields that can be customized. Under each screen name are
branches for the individual fields which can be modified to your preferred terminology. After
selecting the desired field, you can choose the desired label, data type, mask, field size or
UI type. The screens and fields that have been customized appear in bold under the
Customizable Labels list.

I9Customized labels in BillQuick are also reflected in the BillQuick add-ons like BillQuick
Agent and Web Suite.

Reference Info

CUSTOM LABELS

Navigation Settings menu, Custom Labels
The following are descriptions of fields on the Custom Labels screen:

Customizable Labels:
Lists the name or caption of the BillQuick screens and their fields that are available for

customization, say Activity Code, Employee, etc. You can click to open the tree
structure and view the list. Screens whose labels have been customized appear in bold.

Label:

This represents the screen or field name that can be customized. You can enter a new label
or caption (alphanumeric characters) here. The field labels vary in length—6 or 15
characters for some fields; however, the maximum limit is 30 characters. Be descriptive,
but also concise, when replacing the default field label.

For example, many companies track subcontractor and employee academic degrees and
prior experience to aid managers in assigning resources to projects. A sub-contractor with a
business degree who was involved in two wireless network installations, is a prime lead
candidate for a new project. Similarly, an accountant who has worked on multiple bank
assignments in prior positions would be the obvious person to be selected for a new credit
union consulting job. To use these resources, you can change their custom field labels for
the Employee screen to Degree and Prior Exper (15 characters limit) here.

In some cases, changing the label or caption in one screen allows you to make the change
global. For example, Zip can be changed to Postal Code and this change can be
implemented globally in all screens.

ﬂModifying a label changes the label on the screen; the field name in the database is not
changed.

Type:

The data type of a field. This option is available for custom fields in various BillQuick
screens. You can choose an option from the drop-down list—Text for a specified length of
text, Date for a date field, Integer for numerals/digits, Currency for amount with currency
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signs, Decimal for numbers with decimal values, Memo for memo fields, and Memo RTF for
memo fields that can be stylized in the rich text format. For example, if you have selected

numeric data type for Custom 1 field in the Client screen, you can enter numeric values in

that field.

Mask:

Sequence of letters, numbers and punctuation used for entering formatted data. Telephone
numbers, social security numbers, postal codes and tax identification numbers are common
examples. The field size should not exceed 95 characters. The mask field is active only for
selective fields whose field mask can be customized, say Zip, Phone, State, Fed ID, etc.
Otherwise, it is unavailable. You can click the drop-down arrow to select a predefined mask
from the list. Masks contain the following placeholders:

9 Digit placeholder, accepting o~ .. .

? — Letter placeholder,

accepting only uppercase or Mask:
lowercase letter from A to Z _ -
- Character placeholder, SiIZ& 595.99.9959
accepting any ANSI character in Ul Tvoe. 99-333-9999
the ranges 32 to 126 and 128 = gﬁﬁgggiggg
to 255 (These are the numeric  *, .
. Custom List 99-3333-999
codes for keyboard and foreign 599.59.9999
symbol characters.) 99.999 3339
333.953.339
_Punctuation displays as literals, that :Egiﬁgfggggﬁ
is, they help format the data for easy (9+-999-3999
and quick reading. Common 3-339-9393
punctuation includes parentheses (), gaﬁigsﬁﬁégga&
dashes (-), slashes (/), periods (.), 9.999-9999
colons (:) and similar characters. Ay 99995539
Using the placeholders, proper postal 353-9333939
code masks would be 99999-9999 for iif‘&
the U.S. Zip Code and ? 9? -9? 9 for 79
Canada. vyl
Lt
Size: iﬁ?‘&
This option is available for when the 273

data type is chosen as Text. You can
specify the length of text (number of characters) here. By default the size is set to 50
characters.

UI Type:

You can not only define the type of data that can be entered in a field, but also define its
user interface. You can specify the type of Ul a custom field can have—Text Box (textbox to
type in), List (drop-down list that keeps adding new data as you enter), Custom List (drop-
down list with pre-defined values) and Date (date selection).
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Custom List:

This option is available when the UI type is Custom List. It allows you to create custom lists
by choosing Add New in the drop-down or clicking the Custom List link. It opens the Custom
List screen where you can create a customized list of items to be displayed in a drop-down
list. You can assign the same list to multiple records.

Custom Labels Button Panel

Help:
Displays the BillQuick Help in the Custom Labels section.

Print:

Displays a preview of the Custom Labels List report. Preview displays a full screen
representation of a report. It provides you with various options: export, print or email
report, page setup, printer selection, navigation, modify fonts and items, zoom or sort data,
find data, memorize report, etc.

Expand Tree:

This is a toggle button which expands or collapses the tree-structured list. BillQuick provides
a tree structure for all the customizable labels and categorizes them under their respective
screens.

Reset:
Resets or restores the custom labels or masks to the default value.

Save:
Saves and applies changes to the custom labels.

Close:
Closes the Custom Labels screen. Be sure to click Save before closing.

How Do 1

HOW DO I CHANGE LABELS?

To change a label:

1. Open the Custom Labels screen from the Settings menu or toolbar.
Select a screen whose label you want to customize, say Project.

3. Click or press the right arrow key to open the branch. Else, click Expand Tree to
open all branches of the tree list.

4. Select the item to change, and then type the new label in the Label field below (say
Engagement). The Label for the screen title can be up to 15 characters long; field
labels can be up to 9.

5. If you select a Custom field, you can also choose a Type, Size and UI Type for it.

6. Click Save and then Close.

ﬁTo restore a caption or field label to its default terminology, highlight the item in the
Custom Labels list (changed labels are in boldface), then click Reset.
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HOW DO I CHANGE FIELD MASKS?

You might not find a pre-defined mask for zip codes in BillQuick for a specific country. You
might want to limit the way users enter zip codes in Employee, Project, Client, and Vendor
screens. To do so, you can create a new mask.

You can change BillQuick field masks and formats using the Custom Labels screen. You
might want to change the 9-digit (99999-9999) mask and Zip Code label to a 6-digit (?9?-
979) mask and Postal Code label to suit your location or a client's location. These changes
pass on to the reports as well.

To change field masks:

1. Open the Custom Labels screen from the Settings menu or toolbar.

2. Click or press the right arrow key to open the branch. It displays various
customizable field labels on the Project screen.

3. From the tree list, select the field whose mask you want to changed, Zip in this case.
The Mask field below the list is active only when you select a field with a modifiable
mask.

4. In the Mask field, select the desired pre-defined format (placeholders) from the drop-
down list. Alternatively, enter placeholder characters for a special mask, say, for a 6-
digit Canadian Postal Code, enter 999-999 or ?9?-979. For a 3 digit postal code,
enter &&& or &&-&.

5. Click Save and then Yes if you would like to have all other screens with a zip code
field to use this format.

6. When you have finished, click Close.

HOW DO I USE CUSTOM FIELDS?

Custom fields are available in many BillQuick screens, such as Employee, Project, Activity
Codes, Client, Vendor, Budget, etc. You can customize their labels, data type, size or length
of characters and type of user interface according to your needs. A custom field can support
any data type. For example, Text for alphabets and letters, Numeric for numerals and digits,
Date for dates, Currency for an amount with a currency sign, Decimal for decimal values
and Memo RTF for memos that can be stylized in Rich Text Format. You can choose any
type of UI for the custom field. For example, a text box, a date drop-down, an auto-fill
drop-down list or a custom list drop-down.

Using these custom fields, you can track extra characteristics and attributes of master
records. For example, track employee (or vendor) skills and experience to match your
company's needs. You might want to use a custom field in the Employee screen to store the
date the employee received a professional license. For that, you can change its interface to
a calendar drop-down. You might want to have a time entry custom field be used when a
service is provided out of state. For that, you can create a custom list called U.S. State and
make it a drop-down list.

F-.
I@*Custom fields are available in the BillQuick Enterprise edition only.
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To use custom fields:

1. Open the Custom Labels screen from the Settings menu or toolbar.

2. Scroll down to the Employee branch, and then click to open the branch. The
customizable fields on the Employee screen display.

3. Select Custom 1 and then type 'Experience' (without quotes) in the Label field.
4. Select Text for Type and 100 for Size (characters long).
5. Next, select the UI Type from the drop-down list, say Text Box. Click Save.
6. When you have finished, click Close.
To confirm the changes:
1. Open the Employee screen from the View menu, toolbar or navigator.
2. On the General tab, the field label now reads Experience instead of Custom 1 or 2. If
you customized Custom 3, Custom 4 or Custom 5, see the Detail tab.
File Linking

ATTACHMENTS OVERVIEW

You can link scanned files, documents, web links and graphics to BillQuick records like
employees, clients, projects, time, expenses, purchase orders, vendor bills, and so on. For
instance, you might want to attach letters, employee performance reports, contracts,
scanned receipts, site pictures, consultant invoices, bills, documents on your Google Drive,
Dropbox, etc. or paste web links to a You Tube video, blog article, and so on for quick
reference. All this can be done using the Attachments screen in BillQuick, accessible from
various screens and shortcut menus.

The linked file is not stored in your company database; rather this feature just points to its
location. Files can be located anywhere on your computer or your company network. On
clicking, the linked file opens in the native program (if installed on your computer). When
you link files, BillQuick can copy them to a shared folder (specified in Global Settings or
User Preferences screens). Optionally, it can even organize them into folders. You can base
the folder structure on the parent record type such as Project, Client, Time Entry, and so
on. You can view all these files, regardless of the record type, on the Manage Attachments
or Document Management screen (Security permissions are required to access this
information).

If you delete a master record with a linked file, a warning displays. BillQuick displays
with the records or grid columns to make it visually easier for you to identify records having
files attached to them. For example, if an employee links a document to his time or expense
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entry, you can immediately spot the entries having files linked to them by looking at the
Attachment (F) column in the Sheet View or Expense Log grid.

BillQuick also displays the Attachments option on the screens. It has a badge indicating the
number of files attached to a record, if any. You can preview the attachments linked to
billed entries like billed expenses.

BillQuick allows you to link any type of file (with appropriate security permissions):

e Graphics e AutoCAD

e Microsoft Excel e Scanned plans

e Microsoft Word e Scanned research drawings

e WordPerfect e Other scanned document

e Microsoft Visio e Portable Document Format (PDF)
e Web Links

&BiIIQuick will not link programs (executable files), folders or similar files.
Reference Info

ATTACHMENTS

The following are descriptions of fields on the Attachments screen:
Grid

File Name:

Displays the name of the file that has been attached to the BillQuick record. For web links, it
displays 'Linked via URL'. It is basically a hyperlink that takes you to the actual file or web
address upon clicking.

Description:
Displays the description of the attached file in a standard format: File-File Name (with
extension). For web links, it displays 'Web File'.

Date:
Date on which the file or web link was attached to a BillQuick record.

Location:
Displays the location or directory path of the attached file. In case of web links, it displays
the complete URL or web address of the site or reference.

When I attach files, copy them to the shared folder:

Checked, all the files that you have attached to a record locally will be copied to a shared
folder. The location of this shared folder is specified in the User Preferences-Folders or
Global Settings-Folders screen. The User Preferences will override the Global Settings. This
option is enabled or disabled based on the security settings.
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ﬁIn case you want to remove the file from the shared folder, the Remove button will only
remove its reference from this screen. It will not delete the file. You will have to manually
delete it from the shared folder to prevent anyone from accessing it.

Create Folder Structure:

Checked, a standard folder structure is created under the shared folder path as specified in
the Global Settings or User Preferences screen. This option is enabled or disabled based on
the security settings.

ﬁIn case you want to remove the file from the shared folder, the Remove button will only
remove its reference from this screen. It will not delete the file. You will have to manually
delete it from the shared folder to prevent anyone from accessing it.

Attachments Button Panel

Help:
Opens the BillQuick Help in the Attachments section.

Auto Fit:

BillQuick automatically adjusts the grid list so all columns fit in the grid window. Else, the
grid list columns display at default widths. Regardless of the settings, you can adjust
column width manually. By default, this option is on for grids.

Remove:
Removes the link to the attached file or web reference. It removes the reference to the link
from the screen but does not delete the original file.

Add:
Allows you to add a file to the BillQuick record. You can browse for the desired file and then
select it.

Add Link:

Allows you to attach remote files and web links to your BillQuick records. It enhances the
existing Attachments feature by allowing you to link any web reference, such as a You Tube
video, blog article, documents on your Google Drive, Drop box or Sky Drive, and so on.
Clicking this button allows you to paste the copied web link and save it as a reference.

Save:
Saves the attached files or web links to the BillQuick record.

Close:
Closes the Attachments screen.
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MANAGE ATTACHMENTS

Navigation View menu, Manage Attachments

The Manage Attachments screen tracks all the linked files in BillQuick, irrespective of the
screen from where the files are attached. The following are descriptions of fields on the
Manage Attachments screen:

View By:

You can choose to view the linked documents on the basis of the module selected here. For
example, Time Entry, Project, Client, Employee, Vendor Bill, Invoice, and more. You can
also choose to view all the linked files.

Period:

The period determines the time frame for which the linked documents will be displayed in
the grid. You can choose to view all or selected attachments for This Month, Last Month,
etc. You can also choose to view these files for a Custom period or All. When the Custom
option is selected, you must select the Period From-To date ranges from the drop-down
calendars.

Grid

T2

The columns in the grid can be filtered using the funnel filters () based on options like
(All), (Custom), (Blanks) and (Nonblank). In addition, the data displayed in the grid can be
sorted by clicking on any column header.

Field Chooser:
o

Click =1 to open the Field Chooser to hide or show columns in the grid. Check the field
names you want to show in the grid. You can also drag-and-drop fields between the Field
Chooser and the grid. Whether or not fields are hidden, values are recorded to them when
data is entered. By default, some of the fields are already checked and displayed in the grid.
Uncheck them if you want to hide them in the grid. The column names in the Field Chooser
are listed in the alphabetical order.

Date:
Date on which the file or document was attached to the BillQuick record.

Source:
Displays the name of the source or screen from where a file or web reference has been
linked—Project, Client, Employee, Invoice Review, Project Notes, etc.

Description:
Displays the description of the attached file in a standard format: File-File Name (with
extension). For web links, it displays 'Web File'.

Attached By:
This is the ID of the person who has linked files or web links to any BillQuick record.
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File Name:

Displays the name of the file that has been attached to the BillQuick record. For web links, it
displays 'Web Link'. It is basically a hyperlink that takes you to the actual file or web
address upon clicking.

Location:
Displays the location or directory path of the attached file. In case of web links, it displays
the complete URL or web address of the site or reference.

IﬂYou can see the record ID of the source when View By is other than 'All'. E.g., you will
see the Client ID if the View By is selected as 'Client'.

Manage Attachments Button Panel

Help:
Opens the BillQuick Help in the Manage Attachments section.

Layout:
Auto Fit:
BillQuick automatically adjusts the grid list so all columns fit in the grid window. Else,
the grid list columns display at default widths. Regardless of the settings, you can
adjust column width manually. By default, this option is on for grids.
Best Fit:
BillQuick automatically adjusts the grid list so that the columns fit the contents.

Delete:
Removes the selected linked file.

Refresh:
Retrieves the latest data from the database and displays it on the screen.

Close:
Closes the Manage Attachments screen.

How Do 1

HOW DO I VIEW ATTACHMENTS?

To view linked documents or attachments:

1. Open the Manage Attachments screen from the View menu. You can also view them
from the Document Management-Linked Documents and Project Center-Files screen.

2. Select your View By option. For example, choose ‘All’ from the drop-down to view
documents linked to all records, regardless of the type.

3. Select the Period for which you want to view the linked files. It could be All, This
Month or any Custom period.
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4. Click Refresh. BillQuick displays all the relevant files attached to the selected record.

9Using funnel filters, you can further refine the list of linked files. For
example, you can bring up all linked files, and then use a funnel filter to
narrow them to a single employee.

5. You can click on the File Name and open the file in the native program.

To-Do Tasks

TO DO LIST OVERVIEW

Navigation View menu, To Do List

The To Do List screen allows you to create and track various to-do items for employees,
clients, vendors, projects, etc. BillQuick adds these to-do items to the Reminders screen,
thus reminding you to take action on them. Various reports are available displaying the task
list, past due tasks, etc. You can also create time entries from your to-do items. This is an
extremely convenient and time saving feature for timekeepers. Not only does this eliminate
double-entry, it also helps capture more billable time as you work.

The To Do List for a project allows you to add tasks for a project and track the status of
each task. It allows you to assign tasks to employees, set priority on them, specify start and
end dates, track the status of each item and get reminders, thus making project execution
and management as efficient and simple as possible. It supports various types of tasks and
categorization with specific start-end dates. The To Do List can be used to remind you of an
employee’s upcoming review or just manage a list of tasks that you need to complete on a
specific project. In short, a to-do list will help you remain focused and organized.

BillQuick allows you to filter the to-do list by any field. You can limit the list to a certain

entry type by using the funnel filters. BillQuick allows you to export the To-Do List to
Microsoft Excel as a csv file.

&This feature is available in the BillQuick Pro & Enterprise editions only.
Reference Info

TO DO LIST

Navigation View menu, To Do List
The following are descriptions of fields on the To Do List screen:
View By:

Determines the module for which to-do items are to be created or viewed. You can choose
any option —Project, Client, Employee, General, etc.
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Description:
The heading or title of a to-do item.

Assigned To:
The employee or vendor to whom the task or to-do item has been assigned.

Status:
You can set the status for each task here. You can choose any of the relevant status—
Active, Inactive, Hold, Complete and Incomplete.

Task of:
This is the ID of the project, client, vendor or employee associated with the to-do item or
task. The drop-down list changes depending upon what is selected in the View By field.

Priority:

All tasks are assigned a priority, which determines how important or urgent the task or item
is. By default, a new task is assigned a Medium priority. This can be changed to Low or
High.

% Complete:
The estimated percentage of completion of a task. This helps you keep track of how much of
the task remains to be done till the due date.

In case of to-do items related to projects, employees and vendors, you can create time
entries from your tasks upon updating (increasing) the % Complete field. You are prompted
to create a time entry using the Add as Time Entry screen.

Start:
This is the date when the task is scheduled to start.

End:
This is the date when the task is scheduled to be completed. When you specify a due or end
date for a task, it leads to better management of project deadlines.

Remind On:
This is the reminder date for the to-do item or task. It sets a reminder in the Reminders
screen and notifies you about the task when you log in.

Completed On:
This is the date when the task is actually completed.

Memo:

You can add a descriptive memo to the task. Click to open the memo box. It allows you
to enter unlimited text or use Auto Complete shorthand codes.

Grid

The grid displays the details of the previously created to-do tasks or items. When the option
Show Active Only is checked, only active to-do items are displayed in the grid.
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B

The columns in the grid can be filtered using the funnel filters () based on options like
(All), (Custom), (Blanks) and (Non-blank). In addition, the data displayed in the grid can be
sorted by clicking on any column header.

Field Chooser:
o

Click I=1 to open the Field Chooser to hide or show columns in the grid. Check the field
names you want to show in the grid. You can also drag-and-drop fields between the Field
Chooser and the grid. Whether or not fields are hidden, values are recorded to them when
data is entered. By default, some of the fields are already checked and displayed in the grid.
Uncheck them if you want to hide them in the grid. The column names in the Field Chooser
are listed in the alphabetical order.

Created By:
Displays the name of the person who created the to-do list. This field is pre-filled based on
the ID of the person logged into BillQuick.

Task Number:
Assigns a number to the task automatically. If you are creating multiple to-do items, it sets
the numbering for them, say Task 1, 2, 3 and so on.

Memo:
Checked, it indicates that the to-do item has a memo attached to it. You can view the

memo by clicking Memo at the top.
To Do List Button Panel

Help:
Opens the BillQuick Help in the To Do List section.

Print:
Opens the Select a Report window where you can select an in-context report.

Tools

Layout:

e Auto Fit:
BillQuick automatically adjusts the grid list so all columns fit in the grid
window. Else, the grid list columns display at default widths. Regardless of the
settings, you can adjust column width manually. By default, this option is on
for grids.

e Best Fit:
BillQuick automatically adjusts the grid list so that the columns fit the contents.

Make Time Entry:

In case of to-do items related to projects, employees and vendors, you can create
time entries from your tasks even without updating (increasing) the % Complete field.
Click this option to open the Add as Time Entry screen.
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Send to Excel:
Allows you to send or export the selected data to an Excel spreadsheet. You can save
the file to the desired folder.

Copy Existing:

Allows you to create a new to do item based on an existing item. When you click this
toggle button, it displays the Existing To-Do field, which allows you to choose an
existing to-do item from the drop-down list. On selecting an existing item, those
details are carried forward to the new to-do list on clicking copy. These details can
be edited and saved as a new task.

Delete:
Deletes the selected record or to-do item in the grid.

Cancel:
When you are creating a new to-do item or task, this button is available. It allows you to
cancel any changes or action.

New:
Allows you to create a new task or to-do item.

Save:
Saves a new to-do item or changes to an existing item.

Refresh:
Retrieves the latest data from the database and displays it on the screen.

Close:
Closes the screen. Remember to save your changes before closing.

How Do I

HOW DO I CREATE TO DO LISTS?

To create a to-do task or list:
1. Open the To Do List screen from the View menu.

2. Click New to create a new task. Optionally, you can click Copy Existing and select
an existing task to copy.

3. Enter a heading or title for the task in the Subject field, say Correspondence.
4. In the Assigned To field, specify the ID of the person to whom this task is assigned.

5. Set a Priority for this task—Low, Medium or High. You can also indicate the
percentage of completion of this task in the Complete (%) field.

6. You can enter the Start and End dates for the scheduled task. In addition, enter a
Remind On date. BillQuick will remind you about this task on that date.
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7. If required, type a Memo for this task. You can enter unlimited text here.
8. When you are done, click Save and then Close.
Reminders

REMINDERS OVERVIEW

Navigation View menu, Reminders

System-generated and user-defined messages display on the Reminders screen. System-
generated messages inform you about actions to take, such as print invoices, approve time
entries, process recurring invoices, and so on. Who receives a reminder depends on the
option chosen, role in the company and billing decisions. What you view on the Reminders
screen is tied to your security settings and is specific to your responsibilities. You can view
some reminders only if they have been set for you in the in the Employee and Vendor
screens (see Settings Reminders for details).

Date-triggered reminders use your computer’s system date to determine when to deliver
the reminder. Due Date reminders start showing up in the Reminders screen 7 days prior to
due date (it is customizable from the User Preferences-Notification and Reminders screen).
BillQuick triggers some reminders when you specify those options in the Global Settings or
User Preferences screens.

The Reminders screen displays information on two tabs. The system or user-generated
reminders are displayed on the Reminders tab. On the Settings tab, you can decide which
reminders to view by checking the relevant options. BillQuick saves these settings for you.

9The Reminders screen displays reminders for only those screens to which you have
access (as defined in Security).

You can view the following reminders on the Reminders screen:

Backup reminders

Project due dates

Billing reminders

Scheduled billings

Invoice reminders

Important dates with messages
Time and expense reminders
PTO reminders

PO and vendor bill reminders
Unsaved timers

To-do tasks and notifications

Reminders are automatically set for the time and expense entries that are unapproved. It
displays a reminder message to approve the submitted time and expense entries,
depending on the type of BillQuick User. If you have logged in as a Supervisor, the reminder

BillQuick | Power Up Your Business 119
(866) 945-1595 | www.bge.com | info@bge.com


http://www.bqe.com/
mailto:info@bqe.com

(bqe BillQuick HELP MANUAL

messages will pertain to approving the time and expense entries of other employees. If you
have logged in as a Project Manager, the reminder message will pertain to approving the
time and expense entries of projects assigned to them. If other employees have logged in,
then the reminder message will pertain to informing them about the unapproved time and
expense entries till date.

ﬁThe Reminders screen also saves a list of all unsaved timers. However, if Reminders is
not set to Auto Load, a message will be displayed on BillQuick startup reminding you of
unsaved timers.

You can also get a reminder for the project due dates. This enables you to track the contract
expiration or due dates for the completion of projects. Besides these, Reminders screen also
shows all the recurring projects which are due on the current date. Selecting them and
clicking View opens the Billing Review screen with these projects pre-filled.

The Personal Time Off Request reminders notify the approver for the approval of these PTO
requests. Double-clicking on the reminder message or clicking View opens the Personal
Time Off Review screen, where you can approve or reject the requests.

Reference Info

REMINDERS

Navigation View menu, Reminders
The following are descriptions of the fields on the Reminders screen:
Reminders Tab

Description:
It displays the description of the reminder. For example, “Backup-There is no backup file”,
“You have 25 unprinted invoices”, and more.

Date/Amount/Due Date:
Date or due date related to the descriptive message or reminder. In case of invoice
reminders, it displays the total dollar amounts rather than dates.

Settings Tab

Reminder Description:

Lists the name of the reminder that you can view on the Reminders tab. It could be
Employee Reminders, Project Reminders, Backup Reminder, Time Entry Reminders, Billing
Reminders, etc.

Remind Me:
Displays a checkmark for the reminders which you want to view. You can un-check the ones
which you do not want to view. By default, they are all checked.
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Reminders Button Panel

Help:
Opens the BillQuick Help in the Reminders section.

Auto Load:
Auto loads or opens the Reminders screen on BillQuick startup.

Remove:

Deletes the selected item in the reminder list. BillQuick remember this for the session but
resets it upon exiting BillQuick.

View:

Displays the relevant message details or actual screen related to the reminder. You need to
select an item in the grid and then click this button to view the details.

Refresh:
Retrieves the latest data from the database and displays it on the screen.

Close:
Closes the Reminders screen.

How Do 1

HOW DO I SET REMINDERS?

BillQuick allows you to create reminders. As an example, if you are a manager or a
supervisor, you might want a reminder a few days prior to an employee’s birthday.
Alternatively, you might want a reminder about arranging your next out-of-town meeting
and so on.

To set reminders:
1. Open the Employee screen.
2. Select the employee from the grid for which a reminder is to be set.

3. Move to the Rate tab. In the Reminders section, type a Reminder Message and enter
the Date on which you want that reminder message.

4. In the Reminders For field, select an employee or group for whom the reminder is
intended. Only the specified persons receive the reminder message. If you specify
none, then BillQuick sets it for the employee manager.

5. Optionally, enter an Important Date and then check the ‘Remind me about the
Important Date’ option. As an example, you might want to enter your employee’s
next review date.

On the set date, the Reminders screen will display this reminder for you.
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6. In the Reminders screen (View menu), you can select the employee reminder and
directly access the Employee screen. You can also send a message to the employee
using the shortcut menu.

ﬂSimiIarIy, you can set reminders for your vendors or consultants in the
Vendor screen.

HOW DO I VIEW REMINDERS?

To view and access reminders:

1. Open the Reminders screen from the View menu or toolbar. To load it automatically
on startup, click Auto Load on the Reminders screen.

2. Double-click on any reminder or click View to drill-down to its details.

3. For time and expense reminders, you can select a parent (main) reminder and right
click to choose View by Employee or View by Project.

4. When you are done, click Close.

5. You can also view your reminders on the navigator.

i
'@'5% Setting Global Reminders for more.
BillQuick Messages

BILLQUICK MESSAGES OVERVIEW

Navigation View menu, Messages

BillQuick Messages is a feature that allows real-time messaging within the BillQuick
network. BillQuick users can exchange messages with each other, groups or within their
network for better communication and notifications.

@-This feature is available in the BillQuick Pro & Enterprise editions only.

BillQuick Messages feature delivers contextual messages to users based on a trigger event.
For example, it can deliver a time card rejection message when you log in or when you open
a time entry screen. Alternatively, you can receive a message about billing a project when
you open the Billing Review screen. This improves communication by notifying, reminding or
advising another user within the context of the task at-hand. BillQuick also sends
notifications and automatic messages to its users via this feature. For example, you can
choose to let BillQuick send notifications via BillQuick Messages when someone submits or
approves time entries, expenses, invoices, and so on. The notifications only show when the
navigator is open (make sure your user preferences have the navigator turned on).
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The BillQuick Messages screen has three tabs—Inbox, Sent and New Message. It enables
you to view messages in the Inbox as well as the Sent items panel. It also implements the
Auto Complete feature of BillQuick.

Reference Info

BILLQUICK MESSAGES—NEW MESSAGE TAB

Navigation View menu, Messages

You can create a new message by clicking on the New button on the BillQuick Messages
screen. It displays the New Message tab.
The following are descriptions of fields on the BillQuick Messages-New Message screen:

Send To:

You can send a message to Selected Employees or an Employee Group. You must select
the desired employees or group from the drop-down list. Only BillQuick Users can receive or
send messages using this feature.

Display this message when recipient:

You can set the option as to when the recipient should get the message. You can decide
whether BillQuick should displays the message when the recipient does billing, runs report,
records time, logs in and so on. The notification is triggered by the activity performed by the
receiver of the message. This ensures that you get the message at the right time.

Message:
You can enter text or customize message of unlimited length into the message box.

BILLQUICK MESSAGES—INBOX TAB

Navigation View menu, Messages

The Inbox tab of the BillQuick Messages screen displays all the messages sent to you. You
can view the messages sent by other BillQuick Users within your network.

The following are descriptions of fields on the BillQuick Messages-Inbox screen:

Date:
Displays the date of the message. It is the date when the message was sent to you by
another user in your BillQuick network.

Message From:
Sender of the message. It displays the ID of the BillQuick User within your network who has
sent a message to you along with the name.

Message Read:

Displays - to represent unread messages. It is blank for all other messages read by you.

BillQuick | Power Up Your Business 123
(866) 945-1595 | www.bge.com | info@bge.com


http://www.bqe.com/
mailto:info@bqe.com

(bqe BillQuick HELP MANUAL

Message Sent For:
Displays different icons to indicate when the message is supposed to appear for the

recipient. For example, it displays to indicate that the message will display when the

recipient records time or I:\ when the recipient logs in.

Files Attached:
Displays = to indicate that files are attached to the message.

The content of the message displays on the right panel.

ﬂThe unread messages are in bold font.

BILLQUICK MESSAGES—SENT TAB

Navigation View menu, Messages

The Sent tab of the BillQuick Messages screen displays all the messages sent by you to
another user. The following are descriptions of fields on this screen:

Date:
The date of the message. It is the date when the message was sent by you.

Message To:

Recipient of the message. It is the ID of the BillQuick user within your network to whom the
message was sent.

The content of the message is displayed on the right panel.

How Do 1

HOW DO I SEND MESSAGES?

To create and send a message:
1. Open the BillQuick Messages screen from the View menu.
2. Click New to create a new message.
3. You can send a message to one employee (or vendor), multiple employees or a
group of employees (or vendors). Select the desired Employees or Employee Group

as the recipient of the message.

4. Set the trigger event to determine when to deliver the message. For example, when

a user:
e Logsin e Uses Payment screen
e Records expenses e Does billing
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e Records time e Uses Purchase Orders screen

e Runs reports e Uses Vendor Bills screen

e Opens any master e Opens Reviewer screen
record

5. Type your message for the recipient. You can use Auto Complete shorthand codes for
your convenience.

6. Click Send to send the message. You can preview your message on the right panel.

7. Select the message in the Sent list and click Attachments to attach any web link, file
or document with this message. See Attachments for more information.

8. When you have finished, click Close.

When the trigger event occurs, the recipient receives a BillQuick Message Alert. Clicking on
the link opens the BillQuick Messages screen. After receiving a message, the recipient can:

e Reply to the message (BillQuick automatically directs the reply to the sender.)

e Forward the message to one or more BillQuick Users
e Delete the message

Email

EMAIL

BillQuick allows you to email invoices, statements, reports, purchase orders, bills, etc. to
your clients, employees, managers, vendors or any other person. You can also send
attachments via email. Before using the Email option, you should have a dedicated email
address specified in the User Preferences-Email Settings or Global Settings-Email Settings
screen.

When you click on the Email button in any BillQuick screen, it opens the Compose Email
screen. The following are descriptions of fields on this screen:

To:

The email address of the person to whom you want to send an email. This is the email ID of
the recipient. BillQuick uses Auto-Complete to suggest email addresses as you start typing
them.

Cc:
The email address of the person to whom you want to send a carbon copy of your email. It
can be your own email ID.

Bcc:

The email address of the person to whom you want to send a blind carbon copy of your
email. It can be your own email ID or that of any other person you want to email but not let
others see it.
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Subject:
The subject of the email. It is usually pre-filled for emails with file attachments, such as
invoices, reports, etc. It can be pre-defined in the Global Settings screen.

Attachment:

The files appended or linked to the email message. BillQuick allows you to automatically
attach all the files linked with an invoice to the email message. You can further see a list of
attachments for the email by clicking on the drop-down with the option to select or deselect
the ones you want. You can also click on the attachment name to preview it.

Send Invoice Attachments as a Single File:
When checked, BillQuick automatically zips all the invoice attachments as a single file,
making it easy for your client to view all the attached documents inside one folder.

Send Message as Plain Text:
Checked, the content of the email message will be sent as plain text, without any formatting
like Bold, Strike-Out, Underline etc., if applied.

You can write the email message in the text box provided to you. When ready, you can send
your message by clicking Send.

Email Button Panel

Help:
Opens the BillQuick Help in the Email section.

Address Book:
Opens the BillQuick Address Book screen. You can select the contacts to whom you want to
send the email.

Spell:

Gives you a more flexible way of correcting your spelling mistakes, adding new words to the
in-built dictionary or even ignoring them and so on. When clicked, it opens the Spelling
screen displaying your text and highlighting the misspelled word in red color.

Close:
Closes the Compose Email screen.

Wizards

WIZARD OVERVIEW

Navigation View menu, Wizards

A BillQuick wizard is a special form of user assistance that automates a task through a
dialog with you. The BillQuick wizards help you accomplish tasks that can be complex for
the first time users and can require experience. They can automate almost any task, such
as setting up a new company file; creating new employees, projects, clients, and more;
converting data from other programs; generating invoices and so on. Typically, a BillQuick
wizard consists of three or more pages.
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How Do 1

HOW DO I USE WIZARDS?

Wizards are special screens that step you through a task, easily and quickly. BillQuick
provides various timesaving and simple wizards for first-time users.

To use a wizard:

1. Open a wizard from the View menu, Wizards or the Sidebar, Wizards. Several
navigators also include links to wizards.

2. Follow the instructions on each page and enter or select the desired data.

3. Navigation in all wizards follows the same pattern:

e Click Next to move to e Click Finish to save
the next page. the new record.
e Click Previous to move e Click Cancel to close
back one page. without saving data.
How Do 1

HOW DO I CUSTOMIZE BILLQUICK?

BillQuick screens follow industry-standard designs. The screens contain data fields and grids
making it easy to scan, enter and edit data. However, you can customize BillQuick in many
ways.

e You can set the screens as tabbed/non-tabbed windows (User Preferences screen).

e You can customize the grids by turning on/off columns, re-sizing columns,
rearranging columns and sorting data with a click of the mouse.

e You can change the tab position (left or right) in various BillQuick screens by
dragging-and-dropping them. For example, you might prefer having Detail tab before
the Rate tab in the Employee screen.

e You can adjust screen dimensions as needed. To maximize the screen, click . To

restore it to its previous size, click . You can also manually change the size by
clicking in the lower right corner of the screen and dragging it. BillQuick remembers
the window size on your computer from one session to the next.

e You can customize BillQuick terminology to industry and company preferences,
including changing captions, field labels and field masks (BillQuick Start-Up Interview
and Custom Labels screen). The changes apply throughout BillQuick on menus,
screens and reports. For example, you can change the Company screen title to Firm.
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You can customize the Custom field labels or change the input masks for phone
number and zip code.

e At a global level, business rules can be set to match company policies and industry
standards. For example, with a single click you can set BillQuick to adhere to DCAA
requirements (Global Settings screen).

e You can set or change the theme of the BillQuick program from the User
Preferences-Appearance screen. From here, you can also control the time and
expense entry colors.

In short, BillQuick adapts to you, your company policies and your industry.

BillQuick | Power Up Your Business 128
(866) 945-1595 | www.bge.com | info@bge.com


http://www.bqe.com/
mailto:info@bqe.com
http://www.bqe.com/media/PDF/BQ/2016/DCAA-Compliance-Guide-2016.pdf
http://www.bqe.com/media/PDF/BQ/2016/DCAA-Compliance-Guide-2016.pdf

(bqe BillQuick HELP MANUAL

MASTER INFORMATION SETUP

Company

COMPANY OVERVIEW

Navigation View menu, Company

The Company screen allows you to create a profile of your company and business. All
information entered in this screen can be used in reports and invoices. You can modify any
information—except for the company name and license keys. Changing the company name
or a key will make your company database inaccessible.

The Company screen has two tabs: General and License. Besides maintaining the company
information here, you can also add logos to your reports and perform licensing tasks.

Company profile can be customized by modifying the labels and masks of various fields in
the Custom Labels screen. For example, the caption Company can be changed to Firm or
Practice. When you change this label, the change is reflected in the menu and other
screens. You can also customize the custom fields for a purpose unique to your firm, or
change the input masks for telephone numbers and postal codes.

BILLQUICK SUPERVISOR

A BillQuick Supervisor or administrator is a special user who has abilities that no other user
has, with full security permissions to access all features of BillQuick. The Supervisor
manages the security permissions and access levels of other employees in BillQuick. It is
the Supervisor who decides on the balance of permissions that will maximize each user's
interaction with BillQuick, while also protecting sensitive information and functionality. The
Supervisor can grant or terminate security permissions from any computer on a network
that has BillQuick installed on it.

By default, a login is created titled 'supervisor'. This is both the login name and password of
the Supervisor but we recommend changing it. Neither user IDs nor passwords are case
sensitive. If you do not change your password, anyone can log in as a Supervisor and
access or modify anything in BillQuick. You can create an employee record for yourself in
the Employee screen and mark yourself as a BillQuick User. In the Security screen, full
access should be assigned to this Employee ID. You should use the 'supervisor' login only as
a backup. Security screen pre-selects Supervisor if you are logged in as a Supervisor or if
the security is turned off.

There are other tasks that only a supervisor or administrator can do (recommended):

e Turn on/off security for the company

e Change user's access permissions

e Change company related information such as company name, address, fiscal year,
and so on.

e Enter the name of the person who will be the administrator

e Import and export data

e Set up company database
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If you need to do one of these tasks, have your company supervisor do it for you. Because
of our desire to keep the security mechanism of BillQuick as tamper-proof as possible, we
will not explain how to access a database when the supervisor's password has been
forgotten. If this situation arises, contact our Technical Support by phone at (310) 602-
4030, by fax at (310) 784-8482 or by email at support@bge.com for an authorization key.
Be sure to include your company name when submitting a support email.

Reference Info

COMPANY—GENERAL TAB

Navigation View menu, Company
The following are descriptions of fields on the Company-General screen:

Name: (required)

The company name is a required field for maintaining a licensed BillQuick database. The
field size cannot exceed 95 characters. This field will appear on all invoices and statements.
Your BillQuick license key is based on your company name.

You must enter the licensed company name in this field as it appears on the licensing and
registration instructions provided upon your purchase of BillQuick. The exact spelling,
spacing and punctuation are required, although it is not case sensitive. If the company
name is changed after the database is licensed, the result will be an unlicensed BillQuick
database. Please consult BillQuick Technical Support support@bge.com in case you change
the company name.

Address:

The company's street address; it appears on all invoices and statements. The field size for
the first line cannot exceed 55 characters. The field size for the second line cannot exceed
35 characters.

City:
The city where your company is located. This will appear on all invoices and statements.
The field size cannot exceed 45 characters.

State:

The name of the state or province where the company is located. The field size cannot
exceed three characters. This field will appear on all invoices and statements. The label and
mask for this field can be modified in the Custom Labels screen.

Zip:

The zip or postal code of the area where the company is located. This field will appear on all
invoices and statements. The label and mask for this field can be modified in the Custom
Labels screen. The field size cannot exceed 10 characters.

Country:
The name of the country or region where the company is located. The field size cannot
exceed 35 characters.
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Phone:

The company's phone number. Up to 25 characters are allowed for the main telephone
number. This field will appear on all invoices and statements. The mask for this field can be
modified in the Custom Labels screen.

Fax:

The company's fax number. Up to 25 characters are allowed for the main fax number. This
field will appear on all invoices and statements. The mask for this field can be modified in
the Custom Labels screen.

gThe labels and mask for some fields can be modified in the Custom Labels screen. In
some cases (Zip, Phone, Fax and State), changing the label in one screen prompts you to
make the change global. For example, Zip can be changed to Postal Code and this change
can be implemented globally in all screens.

Email:
The company's email address. The field size cannot exceed 150 characters. Clicking on this
field opens your default email program.

Web:
The company's Uniform Resource Locator (URL) or web address. Clicking on this field opens
this website in your default browser.

Tax ID:
The company's tax identification number. The field size cannot exceed 20 characters.

Employer ID:
The company's employer identification number. The field size cannot exceed 9 characters.
The mask for this field can be set in the Custom Labels screen.

Currency:

BillQuick supports multiple currencies and gives you the ability to specify expenses in a
currency other than your local currency. Hence, you can enter your expenses in a foreign
currency and bill the client accordingly. Here, you can set your default home or local
currency so that the proper amount, multiplier and symbols are used at relevant places
(say, in Expense Log). BillQuick also uses this company currency for the purchase tax amount instead of
the system currency. When you specify a currency other than the system default, you are
prompted to restart BillQuick for the change to take effect. If you change the home currency
here, the currency on the reports will change automatically. This selection can be
overwritten at the employee level.

Example: If your main office is in USA but your employee CJ is working in your U.K. office,
you can specify the United States Dollar (USD) here but the British Pound as his default
currency in the Employee screen. Whenever CJ logs his expenses, they will be recorded in
British Pound according to the multiplier specified (in Currency Manager or Expense Log).
When other employees log their expenses, they will be recorded in USD.

BillQuick 